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This section describes the overall functionality of the NB-Link communications device. Step by step 

instructions are provided for connecting and configuring the NB-Link. 

 

 

Interfacing with Controllers 

NB-Pro employs standard point-and-click navigation found in most Microsoft Windows applications. Using 

NB-Pro, end-users can configure Native BACnet devices, as well as manage an entire network. 

 

In order for end-users to interface with Native Series Unitary Controllers using NB-Pro, devices must be 

connected to NB-Link. NB-Link is an external, Native BACnet MS/TP to UDP protocol transporter. It is used to 

offload the communication overhead of BACnet MS/TP from the host PC. Used in conjunction with NB-Pro 

commissioning software, this provides a direct interface to a BACnet MS/TP network that is free of packet loss and 

communication errors. 

 

When the connection between NB-Pro and NB-Link is established, BACnet MS/TP packets are transmitted from 

NB-Link directly to the NB-Pro user PC via a direct TCP socket connection. When the TCP packets are received by 

NB-Pro, the data packets are then converted to ‘upper layer’ PDUs (Protocol Data Units) relative to BACnet 

MS/TP. 

 

Requests made to an MS/TP device are then sent as TCP packets to the NB-Link. Once received by NB-Link, the 

data request (write, property updates, etc.) is made to the MS/TP device. The connection between NB-Pro 

and NB-Link is a dedicated one-to-one connection. NB-Pro also allows users to perform capture 

upload/download, controller based SPL programming, as well as flash maintenance. 

 

Native Series Unitary Controllers or third party BACnet MS/TP devices connect to NB-Link using 18-22AWG, 

two-wire, shielded twisted-pair RS-485 (EIA-485). The physical connection to the NB-Link from the MS/TP 

network is made using the DB25, a simple converting device that is supplied by AAM with NB-Link. Enhancements 

and updates to NB-Link can be applied through NB-Pro via an Internet connection to the American Auto-Matrix 

product server. 
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Connecting The BACnet Network 

To connect the controller network to NB-Link, use the supplied DB25 device. Connect N+ of the Unitary 

Controller network to the Tx+ terminal of the DB25, and N- of the controller network to the Rx- terminal of the 

DB25. The DB25 is illustrated in Figure 1-1. 

 

Connect N+ and N- of the NB 

Unitary Controller to Tx+ and Rx- of 

the DB25, respectively. 

 

Connect the DB25 device 

(male 25-pin connector) to 

NB-Link (female 25-pin 

connector). 
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Connecting NB-Link to a PC 

NB-Link is equipped with an RJ-45 connector for Ethernet connection. If you are connecting NB-Link 

directly to your PC, you must use a network crossover cable. Otherwise, use a patch cable to connect the NB-

Link to a hub or switching device located on your local area network. Refer to Figure 1-2 for more 

information on connection ports. 

 

 

 

Figure 1-2: NB-Link Connections 

 

Once you have connected the BACnet MS/TP device network to the DB25, the DB25 to NB-Link, and NB-

Link to your Ethernet network, you are ready to install the NB-Pro software. 

 

Important!!! Supply power to 

the NB-Link using the 

provided power supply. The 

required input voltage is 9-

30VDC (3 W maximum). 

RJ-45 Connector - Use a 
crossover cable if connecting  
directly to the PC, otherwise 
connect to a hub or switching 
device located on your Ethernet 
network using a patch cable 

DB-25 Connection Port 
allows direct connectivity 
with BACnet MS/TP 
network 
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NB-Link Set-Up 

Configuration of the NB-Link device is performed through the NB-Pro software. To properly configure the NB-

Link, you must determine the IP address of your computer, connect to the NB-Link using NB-Pro, and configure 

the NB-Link to communicate with your computer. 

 

The IP Address of your PC is found in the Control Panel. To determine the IP address: 

 

1. Open Control Panel in Windows by select Start>Control Panel. If you are working in Classic 
Mode, click on Start, then point to Settings, then click on Control Panel. 

2. Double-click on the Network Connections icon. 

3. Double-click on the network card. 

4. Click on the Properties button. 

 

 

Figure 1-3: Network Settings 

 

5. Select TCP/IP from the Configuration dialog box. 

6. Click on the Properties button. 
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Figure 1-4: TCP/IP Properties 

 

7. The IP address of the computer will be listed in the IP Address field. 

 

Once you know the IP address of your PC, you must connect to the NB-Link through the NB-Pro software. To 
do this: 

1. Open the NB-Pro application. 

2. Select the NB-Link Preferences from the NB-Link menu or press F7. You will see the window 
shown in 

 
 



 
 
 

MAN0122US  Rev 5 © American Auto-Matrix 11 

 

Figure 1-5 NB-Link Preferences 

 

3. If the IP address of your PC is not 192.168.6.1, enter the IP address of your PC in the Remote IP 
Address field. 

4. Click the Get NB-Link Properties button. 

 

You can now configure the NB-Link to communicate with your PC by entering the IP address and other 
network configuration information in the preferences window. 

 

1. You may change the default IP address of the NB-Link by entering the desired address and 
subnet mask in the IP Address and Subnet Mask field. The default IP address is 192.168.6.1. 

2. Enter the IP address of your PC in the Remote IP Address field if you did not do so earlier. 

3. Enter the baud rate of your controller network using the Speed drop-down menu. 

4. If desired, you can change default unit ID number by entering the desired value in the MS/TP 
Unit ID field. The default value is zero (0) and, for most applications, should be left at that value 
to facilitate efficient token recovery. 

5. The Max Master field specifies the address up to which the NB-Link will attempt to 

communicate with controllers. For example, if Max Master were set to 99, NB-Link will 
discover devices with ID numbers ranging from 0 to 99 only. It is recommended that you first 
assign all unit ID numbers to controllers on the MSTP network and then set Max Master to be 
just higher than the last assigned unit ID to allow discovery of all possible master devices 
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without sacrificing network performance polling unused addresses. For more suggested 
practices for commissioning, please refer to Appendix C: Commissioning Tips. 

6. When you are finished configuring the settings for the NB-Link, you must click the Update NB-

Link Setting button to write the configuration information to the NB-Link 

 

The NB-Link should now be communicating with the PC and you should now be able to use the NB-Pro 

software to communicate with controllers using the NB-Link. 

 
 

 

 

 



 
 

 

 

 

SECTION 2 :  USING NB-PRO 
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This section describes the functionality of the NB-Pro software package.  Step by step instructions are provided 

for discovering and configuring networked BACnet devices using NB-Pro. 
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NB-Pro System Requirements 

To run the NB-Pro software, your system must meet the following minimum requirements: 

 

 500 MHz Pentium III processor 

 256 MB RAM 

 Microsoft Windows 2000 or Windows XP 

 Microsoft Internet Explorer (version 5.0 or higher) or Netscape Navigator (version 6.0 or higher) or 
Mozilla Firefox (version 1.0 or higher) 

 1024x768 monitor resolution 

 Available USB port for license key. (If a license key is not present, NB-Pro will run in a reduced mode) 
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Installing NB-Pro 

Note: When installing Cylon Engineering Center, v6.76 or later, you will be offered a choice to 
automatically run the NB-Pro installer as part of that installation. 

If you are upgrading from a version of NB-Pro prior to 2.0, you must uninstall your old copy of NB-Pro, 

install the new version of NB-Pro, and update the firmware on the NB-Link. If you are installing a clean 

copy of NB-Pro, there will be no prior version to remove and your NB-Link should have the most recent 
firmware release, so you can ignore the instructions in To uninstall your old version of NB-Pro on page 16 and   
To update the NB-Link firmware  on page 20. 

To uninstall your old version of NB-Pro 

1. Open the Control Panel by selecting Start>Control Panel in Windows XP, or by selecting 
Start>Settings>Control Panel in the classic Windows menus. 

2. Choose Add or Remove Programs. 

3. Scroll down and select the NB-Pro application. 

4. Click on the Change/Remove button. 

 

Figure 2-1 Remove Old NB-Pro 

 

5. A dialog will come up asking if you want to completely remove the selected application. 
Click OK. 
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To Install the new version of NB-Pro 

1. Insert the NB-Pro 2.0 CD into the CD drive on your computer. The installer should run automatically. If it 
does not, navigate to the CD and run the setup.exe program. 

 

2. You will then be prompted with an End User License Agreement. After reading the agreement, select the I 
accept the terms in the license agreement option and click the Next> button. 

 
 

 

Figure 2-2 License Agreement 

 

3. You must then enter your customer information. If multiple users have accounts on the computer that you 

are installing NB-Pro onto, you can make the program available to all users or only the account which is 
being used during the installation. This is also selected in this window. Once the information is entered, 
click the Next> button. 
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Figure 2-3 Customer Info 

 

 

4. You will then choose the Setup type. Choosing Complete will install NB-Pro into its default location (the 
\Program Files\American Auto-Matrix\NBPro directory on the same drive on which Windows is installed). 
Choosing Custom will allow you to select a different location for the installation. 

 

 
 

 

Figure 2-4 Setup 

 

5. The Installer should now be ready to install the NB-Pro software. Make sure to remove any and all USB 
SuperPro Keys before continuing with the installation. 

6. After you have confirmed that no keys are attached, click the Install button. 
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Figure 2-5 Ready to Install 

 

 

7. When the installation is finished, click the Finish button. 

 

 
 

 

Figure 2-6 Installation Successful 

 

After the NB-Pro software is installed, you must update the firmware in the NB-Link. If the firmware is not 

updated, the NB-Pro software will be able to connect to the NB-Link, but it will not be able to discover 
objects or properties or communicate in any way. 
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To update the NB-Link firmware 

1. Launch the NB-Pro software by clicking on the shortcut on your desktop or by selecting it from the Start 
menu. 

2. Select the NB-Link Preferences option from the Settings menu. 

 

 

Figure 2-7 NB-Link Preferences 

 

3. When the NB-Link Preferences window is opened for the first time, it will detect whether or not you have 

the latest firmware in your NB-Link. If you do not have the latest firmware, it will automatically install the 
firmware. 

4. The NB-Link will then be reset. 

5. You are now ready to use the NB-Pro software. 



 
 
 

MAN0122US  Rev 5 © American Auto-Matrix 21 

Polling for objects 

NB-Pro has two avenues by which you can bring up a list of the devices on your BACnet network. You may 

either manually poll the network to discover which devices are present or you can load a previously saved 

list of devices. 

 

Detecting Devices 
There are two ways to have NB-Pro detect the devices on your network, issuing a Who-Is or locating 

devices. Issuing a Who-Is command, either by selecting Discovery>Send “Who Is” or pressing Ctrl-W, will 

send a Who-is command to the network. Controllers on the network will respond to this with an I-am 

message, making NB-Pro aware of the controller. As NB-Pro receives the I-am responses from the 

controllers, those devices will be added to the device list. 

 

The Discovery>Locate Devices option can also be used to discover devices on the BACnet network. This 

option first clears the current device list, removing any devices that have already been added, and then 

sends a Who-is as described above. 

 

NB-Pro waits thirty seconds after starting up before automatically sending a Who-Is and building a Device 

list. This allows you time to load a previously saved Device list before communications commence. 

 

Saving/Loading Device Lists 
Once the devices on the network have been discovered, you can save the device list to avoid having to 

rediscovering them in the future. To save a device list you would select the File>Save Device List option or 

press the F1 key. You will then be prompted for the location where you wish to save the device list. The 

device list will be saved as a text file (.txt extension). Once a device list has been saved, you can load it in at 

any time using the File>Load Device List option or by pressing the F2 key. Loading the device list 

eliminates the need to discover each device, greatly speeding up your access to the devices. This feature is 

especially helpful when a large number of devices are present. 

 

Discovering Object Lists 
Once the object list has been built or loaded, you can discover the object list for the devices listed. For GPC 

controllers and third party devices, the object list must be discovered the first time the controller is 

accessed, but will be loaded automatically after that. For ASC, VAV, and V3T controllers, the object list is built 

into NB-Pro. If you wish to force NB-Pro to reload the object list for a controller, you must select the 

Discovery>Discover Object Lists option.  When this option is selected, a checkmark will appear  next to it in 

the menu as shown in Figure 2-8. 
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Figure 2-8: Discover Object Lists Option Selected 

 

The next time a controller is selected while this option is checked, the object list will be reloaded. The 

Discover Object Lists option will then become inactive. If you wish to rediscover the object list from more than 

one controller, you will need to select the Discover Object Lists option again. 

 

You would need to use the Discover Object Lists option, for example, after changing an object’s 

object_name property. Once a program is loaded, the object name will change, requiring the object list to be 

rediscovered. The Discover Object Lists option would force NB-Pro to reload the object list making such 

changes visible. 

 

 

 
 

Working With Object Properties 

After all objects have loaded into the Object Name panel, you can select an object from the object panel to view 
its corresponding properties to the right side of the split pane window. 

 

When monitoring properties, users can encounter the following icons: 

Each property that successfully displays its updated value will be marked . 

A property that is not defined or does not exist in the controller will be marked . 

To update all object properties, click on the selected object name from the Object Panel. 

 

 

NOTE 

When working with a GPC controller, if you change the sensor

type of a Universal Input from digital to analog or from analog

to digital, you must reset the controller and then rediscover the

object list for the change to take effect. To save time, you may

change the sensor type on multiple inputs before

rediscovering the object list. 
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To change the value of a property, simply select the property and edit the value using the Value edit box, or 
corresponding menu. 

 
 

 

Figure 2-9: Devices, Objects, and Properties Displayed in NB-Pro 
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File Menu 

Using the File menu, you can load or save device lists. You can also exit the NB-Pro program from this menu. 

 

Save Device List 

 

 

Figure 2-10: Save Device List 

 

The Save Device List option allows you to save a list of the currently discovered devices to a text file. The list 
will be saved as a plain text (.txt) file. This list can be loaded at a later time using the Load Device List option, 
eliminating the need to discover devices. 

 

Load Device List 

 

 

Figure 2-11: Load Device List 
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By using the Load Device List option, you can load a previously saved device lists into NB-Pro. This 
eliminates the need to discover controllers on the network and, if there are more than a few devices, will 
greatly reduce the time before you can begin working with them. 

 

Exit 

 

 

Figure 2-12: Exit 

 

The Exit option is used to close the NB-Pro program. 
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Settings Menu 

NB-Link Preferences 

To set the preferences for NB-Link, select NBLink from the Settings menu: 

 

Figure 2-13: NB-Link Preferences 

This opens the NB-Link Preferences dialog: 

 

Figure 2-14: NB-Link Preferences 

 

This window has a number of fields that allow you to enter configuration information for NB-Link: 

IP Address - The IP address of the NB-Link on your local network. The default IP Address for the NB-Link is 
192.168.6.1. 

Subnet Mask - The subnet mask associated with the NB-Link’s IP address. The default Subnet Mask for the 

NB-Link is 255.255.255.0. 

Gateway Address - If your IP network is configured in such a way that communication between the NB-Link and 
the remote PC are routed through a gateway, the address of the gateway is entered here. If your installation 
does not use a gateway, you should leave the Gateway Address set to the default value of 0.0.0.0. 

Speed - The speed of the MS/TP network to which the NB-Link is connected. 

Remote IP Address - The IP address of the remote PC running NB-Pro. The default Remote IP Address for the 

NB-Link is 192.168.6.2. 
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Remote Port - The network port on the remote PC used for communications with the NB-Link. In almost all 
cases, you should not change this value from its default setting of 17284. 

Local Port - The network port on the NB-Link used for communications with the remote PC. In almost all 
cases, you should not change this value from its default setting of 10001. 

MS/TP Unit ID - The unit ID number for the NB-Link. The default MS/TP Unit ID is 80, but it is recommended 
that you change this to a value of 0 to aid in token recovery. 

MS/TP Max Master - Specifies the address up to which the NB-Link will attempt to communicate with 
controllers. The default value for MS/TP Max Master is 127, but it is recommended that, after you assign all unit 
ID numbers to controllers on the MSTP network, you then set MS/TP Max Master to be just higher than the 
last assigned unit ID to allow discovery of all possible master devices without sacrificing network performance 
polling unused addresses. 

MS/TP Max Info. Frames - The maximum number of data frames that will be sent at before the NB-Link passes 
the token. The default value for MS/TP Max Info. Frames is 10 and that value should be adequate in most 
situations. 

 

When enhancements to NB-Link are made available, it can be upgraded through NB-Pro. NB-Link updates 
are made via an Internet connection to the AAM product server. Perform the following procedure to upgrade 

the NB-Link: 

1. Click on NB-Link in the NB-Pro menu bar. 

2. Highlight and click on NB-Link Preferences (or simply press the F7 key). 

3. If you are connected, the IP address, serial number, MAC Address and firmware revision are 
displayed. If this information does not appear, click on Get NB-Link Information. The steps for 
configuring the link can be found in NB-Link Set-Up on page . 
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Network Configuration 

Selecting Network Configuration from the Settings menu 

 

Opens the Network Configuration dialog: 

 

 

This dialog allows the following parameters to be configured: 

Communicate Via: 

Choose whether NB-Pro will connect to the BACnet network through NBLink, over a Local IP connection or 
using a Remote IP connection. Local IP is used when the PC is attached to the same network as the BACnet 
router (or connected via a WAN or similar) - so that IP broadcasts can be used to and from the router. If the PC 
is not on the same IP network, then Remote IP is used to allow relaying of broadcasts via a BBMD or Foreign 

Device-capable router. 

Note:  If NB-Pro is being used with the Cylon Engineering Center, it is necessary to set this to Remote IP 

so that NB-Pro does not attach to the BACnet UDP port of the PC, which would block the 

Engineering Center. 
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Specific IP Interface? 

This parameter is required if the PC has multiple Network Interfaces.  

 If the PC has a single interface, this option is inactive and cannot be selected. 

 If this option is selected, then one of the PC’s Network Interfaces must be specified for NB-Link 
communications. 

 If this option is not selected, network routing rules are used. 

BACnet Network 

Set to Any, Local or List 

List or Networks e.g. 5.10,20-30 

This becomes active if BACnet Network is set to List, allowing a list of networks to be defined, with an option to 
Include Local Net. 

 

Specific Router? 

If multiple routers are present on the network, this will restrict communications to a single router.  

If this option is not selected, all routers are available. 

 

BBMD Device  

This allows for a BBMD / Foreign Device-enabled router to be used to relay broadcast messages, when local IP 
connectivity does not provide broadcast capability to the BACnet router.  

This is required when Remote IP is checked. 

Note:  If NB-Pro is being used with the Cylon Engineering Center, it is necessary to register NB-Pro as a 

foreign device on a CBR on the network by entering the CBR’s IP address in this field and checking 
the Register? box. 

 

Register?  

This checkbox indicates that NB-Pro should register as a Foreign Device, in order to receive broadcast 
messages. It should usually be checked. 

 

BACnet Port 

This parameter defines the UDP port number that the routers are configured to use. It is usually 47808 

 

Retry 

If no response is received from a device, NB-Pro will retry Count number of times with a delay of Timeout? 
(ms) between each retry. 
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Discovery Menu 

Locate Devices 

 

 

Figure 2-15: Locate Devices 

 

The Locate Devices option is used to discover devices on the BACnet network. This option clears the current 
device list, removing any devices that have already been added, and then sends a Who-is to the network. As 
controllers respond with an I-am message, they will be added to the device list. 

 

 

Send “WHO IS” 

Send “Who Is” commands NB-Link to send a Broadcast Who-Is message on the BACnet MS/TP network to 
locate additional devices. 

 
 

 

Figure 2-16: Send “Who Is” 
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Add Device 

After using the Locate Devices or Send “Who Is” options, all devices which respond will be added to the 
device list. Because devices configured as slave devices never get the token, they will not respond to the Who-is 
and not be added to the device list. If your network consists of any MS/TP slave devices, you must add the 
slave device manually using the Add Device function. 

 

 

Figure 2-17: Add Device 
 

To add an MS/TP slave device: 

1. Click on Utilities on the NB-Pro menu bar then select Add Device from the drop-down menu. The 
Add Device window, shown in Figure 2-18, will appear. 

 

 

Figure 2-18: Add Device Window 

 

2. Enter the Device Instance number of the device in the Device Instance field. 

3. Enter the Unit ID number of the device in the MAC Address (ID) field. 

4. Click on the Add Device button. 

 

 

 
 

NOTE 

AAM Native Series controller’s device instance defaults to the

controllers serial number. The MAC Address (ID) defaults to

the last two digits of the controller’s serial number. 



 
 
 

32 © American Auto-Matrix MAN0122US  Rev 5 

M
A

N
0

1
2

2
U

S  R
ev 5

 

Discover Object List 

 

Figure 2-19: Discover Object Lists 

NB-Pro is designed to store the object list for a device after the first time it is loaded. This speeds access by 
eliminating the need to rediscover the object list each time a device is selected. The first time a device is 
selected, the object list will be read, and stored in memory so that it will not have to be read again after that. 

However, there are instances when you want to force NB-Pro to re-discover the object list. If, for example, 
you change an object’s object_name property, you would have to re-discover the object list for that change to 

be visible. As another example, when working with NB-GPC controllers, if a universal input is changed from a 
digital to analog input or from an analog to a digital input, you would have to reset the controller and then re-
discover the object list to see the properties for the new input object. 

Rediscover Object 

 

 

There are times, for example when you change the sensor type on a GPC controller, when you would want to 
reload a particular object without having to go through the lengthy process of rediscovering the entire 
object list. The Rediscover Object option allows you to selectively rediscover the properties of a single 
object from the object list.  To rediscover the properties of an object, select the Rediscover Object option. A 
checkmark will be placed to the left of the option in the Discovery menu. The next time you click on an object’s 

name in the object list, NB-Pro will rediscover the properties for that object.  After the properties are 

rediscovered, the checkmark will be cleared and NB-Pro will function normally. If you wish to 
rediscover the properties from another object, simply select the Rediscover Object option again. 
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Utilities  Menu 

Flash Update 

NB-Pro’s Flash Updating feature allows you to flash controllers with the latest firmware or application 
templates. 

 

To Flash Update one or more controllers, perform the following steps: 

 

1. Click on Utilities on the NB-Pro menu bar then highlight and click on Flash Update. Alternately, you 
can press Ctrl-F. The Flash Update window will appear. 

 

 

Figure 2-20: Flash Update 

 

2. Click on the Browse button in the Flash Update window to browse to the Flash Update Library (*.flb) 
file. Once you have selected a Flash Library file, the Library entries will be displayed in the upper 
pane of the Flash Update window. 

3. Select the desired update from the list of Flash Library Entries. 

4. In the lower pane, select the controller(s) you wish to update. You can hold down the Shift or Ctrl 
key while clicking to select more than one controller. 
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Figure 2-21 Flash Update Window 

 

1. Choose the methodology for the flash update: 

Flash Single Device –Flashes a specific controller from the controller list window. You may specify a controller 
by entering the device ID in the Unit field under the “Flash Single Controller” or by selecting it in the Select 
Devices pane. Selecting a single controller in the Select Devices pane will automatically set the Unit field to the 
unit number of the selected controller. 

Flash Selected Device – Flashes multiple controllers selected in the controller list window with the flash file 
selected. 

Flash All – Flashes all controllers of the selected type. For example, if you select NB-VAV (r/t/a/f) from the 
Flash Libraries, all NB-VAV controllers would be flashed. 

Flash Every Device – Flash updates all controllers in the controller list. Each controller will be updated with 
the library entry corresponding to its current firmware. If there is not an update for a given controller or 
the controller has a newer firmware version than the flash library, then an error message will be displayed and 

NB-Pro will move on to the next controller. 

 

 

 
 

2. Once you have selected a Flash entry, selected the controller(s) to be updated, and selected the flash 

method, click on the Flash button. A status bar and the percentage of completion is shown for each 

controller/controller group. 

 

 

NOTE 

The Flash Single Device option is the only one which will allow

you to “backwards flash” an ASC controller, that is flash it to a

lower firmware version. The Flash Selected Device, Flash All,

and Flash Every Device options will only work if the flash file

has a higher version or a higher release number of the same

version of the firmware that is currently installed in the

controller. 
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Figure 2-22: Flash Update Status 

 

When the flash update is complete, the Flash Report dialog will be displayed.  

 

Figure 2-23 Flash Report Dialog 

This dialog has three parts to it. The ID numbers of devices successfully flashed will be displayed in the 
Device IDs Successfully Flashed pane at the top of the window. The ID numbers of any devices that did not 
require the flash update will be listed in the Device IDs Not Needing Flashed pane in the lower left portion of 
the window. If any errors were detected during the flash update, they will be listed in the Device IDs that 
Failed During Flash pane in the lower right portion of the window. The Device ID will be displayed as well as a 
brief description of the error which occurred when trying to flash that device. 
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Time Synchronization 

To synchronize the local_time of devices connected to the BACnet MS/TP network, click on Utilities on the 

NB-Pro menu bar, then highlight and click on Time Synchronization or pressing Ctrl-Y. 

 

 
 

 

Figure 2-24: Time Synchronization 

 

Once the Time Sync window is displayed, click on the Send Current Time and Date button, or manually enter 
the current time and date in the appropriate fields, then click on the Send button 

 
 

 

Figure 2-25: Time Sync Window 
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Upload/Download 

The Upload/Download feature allows you to move files between the controller and the computer 

workstation running NB-Pro. Most of the time the files uploaded or downloaded will be SPL programs or Logo 
files, but some controllers also allow flash updates to be installed by uploading a file to the controller. 

 

 
 

To download a file to a controller, perform the following steps: 

1. Click on Utilities on the NB-Pro menu bar. Select Upload/Download.  Alternately, you can press Ctrl-U. 

 
 

 

Figure 2-26: Upload/Download 

 

2. The Program Operations dialog will be displayed: 

 

 

Figure 2-27: Program Operations window 

 

  

NOTE 

You must load the object list for the controller before you will

be able to upload or download files to that controller. 
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3. Select the controller to which you wish to download a file using the Unit drop-down. 

4. Select where in the controller you wish the file to be downloaded using the Programs list. 

5. Click the Download--> button. 

6. A file browser window will open for you to select the file you wish to download to the controller. 

 

Once selected the file name will be displayed in the box below the Programs field and the program will begin 

to download. The download progress will be displayed by the Progress bar as well as a percentage next to the bar. 

When the program is successfully transferred to the controller, the name of the object will be changed to the 

name of the program. For GPC controllers, the object list must be rediscovered for this change to be visible. 

 

 

To upload a file from a controller, perform the following steps: 

 

1. Click on Utilities on the NB-Pro menu bar. Select Upload/Download. Alternately, you can press 
CTRL-U. The Program Operations dialog will be displayed. 

2. Select the controller from which you wish to upload a file using the Unit drop-down. 

3. Select where in the controller you wish the file to be uploaded using the Programs list. 

4. Click the <--Upload button. 

5. A file browser window will open for you to select where you wish to save the uploaded file. 

 

 

 

 

Set Write Priority 

In BACnet, it is possible for many different devices to try to modify the same device’s object property 
values. If multiple devices tried to write to the same object property, errors could occur and values could be 
set incorrectly. To avoid this, BACnet uses priority arrays to determine the order in which property changes 
will be performed. 

 

A priority array assigns unique levels of priority to the different types of devices that could write values to a 
device. There are 16 prioritizations with Level 1 being highest and Level 16 the lowest. A complete list of 
BACnet Priority Array Levels and their uses is given in Table 2-1. 
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Table 2-1 : Priority Array Levels 
 

Priority 

Level 

 

Application 
Priority 

Level 

 

Application 

1 Manual-Life Safety 9 Available 

2 Automatic-Life Safety 10 Available 

3 Available 11 Available 

4 Available 12 Available 

 
5 

Critical Equipment 

Control 

 
13 

 
Available 

6 Minimum On/Off 14 Available 

7 Available 15 Available 

8 Manual Operator 16 Available 

 

 

By default, NB-Pro writes at Priority Array Level 8. This level can be modified to a different priority if you 
desire. 

 

The Set Write Priority option determines the Priority Array Level at which values are written to the 

controller. The relative Priority Array Level of a value written to the controller determines how the value is 

handled by the controller. For example, control loops typically write at a Priority Array Level of 11 meaning 

that a manually written value with a default Priority Array Level of 8 will have a higher priority (lower priority 

level number) than the control loop and will, therefore, override the value written by the control loop. 

 
 

 

Figure 2-28: Set Write Priority 
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The desired Priority Array Level for writing can be set using the drop-down menu in the Set Writing Priority dialog.  

 

 

Figure 2-29: Set Writing Priority 

This Priority Array Level will be used for all values written to the controller. 

 

Standard Commandable Properties 

A BACnet device may have certain object properties, known as “Standard Commandable Properties”, that may 
only be written to with a priority and only if control is relinquished, provided that the device supports priority 
and control relinquishment. When you finish modifying a Standard Commandable Property in a BACnet 
device, control must be relinquished from that property. 

 

To relinquish control, the value of ‘NULL’ must be written to the present_value of the object, at the Priority level 
you have written with. (For example, if you commanded an Analog Output’s Present_Value to 100.0 at a 
Priority Level of 8, you must write the value NULL with a Priority Level of 8 in order to successfully relinquish 
control of that property). Please note that “NULL” is case sensitive and must be written in all capitals.  Table 
2-2 lists the Standard Commandable Properties that fall under this guideline. 

 

. 

Table 2-2 : Commandable Properties 
 

Object Commandable Property 

Analog Output present_value 

Analog Value present_value 

Binary Output present_value 

Binary Value present_value 

Multi-state Output present_value 

Multi-state Value present_value 
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Report Generator 
The Report Generator option is used to create a listing of the properties in a controller, their values and 

how those values are interpreted. 

 

To generate a report, perform the following steps: 

 

1. Click on Utilities on the NB-Pro menu bar and select Report Generator.  Alternately, you can 
press Ctrl-E. 

 

 

 

Figure 2-30: Report Generator 

 

The Report Generator dialog will open: 

 

Figure 2-31: Report Generator dialog 
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2. Click on the Load File button. 

3. A file browser will open for you to select the controller capture file for which you wish to generate a 
report. The controller name, controller type and firmware version will be shown in the Capture 
Information box and a list of all of the properties in the capture file are displayed at the bottom of 
the window. 

4. Press the Generate Report button to create the report. A file browser window will be opened and 
you will be prompted for where you wish to save the report. 

5. You will be asked whether you wish to view the report that has been generated. 

 

 

6. If you select Yes, the report will be opened, by default, using Internet Explorer. 
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Figure 2-32: Generated Report 
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Manual Read/Write 

The Manual Read/Write option allows you to read or write the value of a property given its object instance 
and property ID number. This can be particularly useful when trying to work with the values of proprietary 
properties in other vendor’s controllers or user-defined properties in an SPL program 

 

 
 

 

Figure 2-33: Manual Read/Write 

 

Selecting Manual Read/Write from the Utilities menu or pressing Ctrl-M will bring up the Manual Read/Write 
dialog: 

 

Figure 2-34: Reading a Property with the Manual Read/Write Window 

 

Reading A Property Value 

To read a property value: 

1. Select the unit which contains the desired property using the Unit ID drop-down menu. 

2. Select “Read Property” from the Service drop-down menu. 
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3. Select the type of object in which the desired property is located. You may either use the Type dropdown 
menu or enter the object identifier number in the Type field. If you use the Type drop-down menu, the 
instance will be filled in automatically. If you manually enter the type, you must also enter the object 
instance of the chosen object type in the Instance field. The ID number for the selected property will be 
displayed in the ID field. 

4. Select the property you wish to read. You may either use the Name drop-down menu to select a property in 
the chosen object or you may manually enter the property ID number or, for AAM proprietary properties, 
the two-letter abbreviation corresponding to the desired property in the ID field. 

5. Once all the necessary information has been entered, the Read button will appear at the bottom of the 
window. 

6. Press the Read button. 

7. The value read will be displayed in the Result Field. 

 

 

Writing A Property Value 

To write a value to a property: 

1. Select the unit which contains the desired property using the Unit ID drop-down menu. 

2. Select Write Property from the Service drop-down menu. The Manual Read/Write dialog should look like 
this: 

 

Figure 2-35: Writing a Property with the Manual Read/Write Window 

3. Select the type of object in which the desired property is located. You may either use the Type dropdown 
menu or enter the object identifier number in the Type field. If you use the Type drop-down menu, the 
instance will be filled in automatically. If you manually enter the type, you must also enter the object 
instance of the chosen object type in the Instance field. The ID number for the selected property will be 
displayed in the ID field. 

4. Select the property you wish to write. You may either use the Name drop-down menu to select a property 
in the chosen object or you may manually enter the property ID number or, for AAM proprietary 
properties, the two-letter abbreviation corresponding to the desired property in the ID field. 

5. Enter the value you wish to write in the Value to Write field. 
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6. Once all the necessary information has been entered, the Write button will appear at the bottom of the 
window. 

7. Press the Write button. 

 

A “value successfully written” message will be  displayed in the Result field unless an error occurs during the 
write operation. 

 

 

Reading And Writing Bitmap Values 

The manual read/write capabilities in NB-Pro 2.0 have been expanded to include bitmap properties.  To 
read or write the value of an individual bit in a bitmap: 

 

 

1. Select the unit which contains the desired property using the Unit ID drop-down menu. 

2. Select whether you wish to read or write the property using the Service drop-down menu. 

3. Select the type of object in which the desired property is located. You may either use the Type 
dropdown menu or enter the object identifier number in the Type field. If you use the Type drop-
down menu, the instance will be filled in automatically. If you manually enter the type, you must 
also enter the object instance of the chosen object type in the Instance field. The ID number for the 
selected property will be displayed in the ID field. 

4. Select the property you wish to read or write. You may either use the Name drop-down menu to 
select a property in the chosen object or you may manually enter the property ID number or, for 
AAM proprietary properties, the two-letter abbreviation corresponding to the desired property in 
the ID field. 

5. Select the bit that you are interested in reading or writing using the Bitmap drop-down menu in the 
Property box. If you do not select a bit, you will read or write the full bitstring. The screenshot 
below shows the Manual Read/Write window configured to read the third bit of the (OB) Output 
Channel Bitmap property from the Thermostatic Control 4 object. 

 

Figure 2-36 Manually Reading the Value of a Bitmap 
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6. If you are writing a value to the chosen property, enter the binary value you wish to write in the 
Value to Write field. For individual bits, enter either 0 or 1. Bitstrings are entered with the right-most 
bit being the least significant bit. When entering full bitstrings, if the value entered is shorter than 
the total length of the bitstring, the value will be padded with leading zeros. 

 

 
 

 

7. Press the Read or Write button, as appropriate. 

 

If you are reading a value, the value will be displayed in the Result field unless an error occurs, at which point 
the error will be displayed. If you are writing a value, a “value successfully written” message will be displayed in 
the Result field unless an error occurs during the write operation. 

 

Stat Display Sequence Editor 

 

 

Figure 2-37: STAT Display Sequence Editor 

 

The STAT Display Sequence Editor option is used to configure custom display sequences to be displayed on SBC-
STAT3, SBC-RH3s, and SBC-RHTs connected to controllers in the GPC family. Please refer to  Section 4: Custom 
Display Sequences in the STAT User Manual (AAM part # 1E-04-00-0103) for a complete discussion of the 
creation and configuration of custom display sequences. 

 

  

NOTE 

When working with GPC controllers, the least significant bit is

the left-most bit in the bitstring not the right-most bit like in

other controllers. When writing to a bitstring on a GPC, you

must enter a value for all 24 bits of the bitstring or leading

zeros will  be added, resulting in an incorrect value being

written. 
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Set Refresh Rate 

 

 

Figure 2-38: Set Refresh Rate 

 

In previous versions of NB-Pro, if changing one property’s value affected the values of other properties, to see 

the effects of the change, you had to click on the object and reload the property list. NB-Pro now can be 

configured to automatically update the values of properties displayed in the right hand pane of the NB-Pro 
window. Selecting the Set Refresh Rate option from the Utilities menu will open the Refresh Rate dialog: 

 
 

 

Figure 2-39: Set Refresh Rate Dialog 

 

You may enter the number of seconds you wish to elapse between refreshes in the box. You may also 
disable the automatic refreshing by clicking the Disable button. The current state of the refresh, either 
enabled or disabled, will be displayed in the lower left corner of the dialog. 

 

 

 
 

 

NOTE 

For AAM ASC-based controllers and other controller which do

not support ReadPropertyMultiple, setting the refresh interval

to too small a value may cause an disproportionate amount of

time to be spent refreshing values. This can adversely affect

the ability of the user to operate NB-Pro. 
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Property Information 

Prop Id Lists 

The Prop ID Lists option provides a way for you to look up the property identifier numbers for any property 
contained in your controller. 

 

 

Figure 2-40: Prop ID Lists 

 

To view a list of the property ID numbers: 

Select Prop ID Lists from the Utilities menu.   Alternately, you can press Ctrl-L. 

This will bring up the Property ID Lists dialog: 

 

Figure 2-41: Property ID Lists dialog 
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Select the controller type using the Device Type drop-down menu. 

Select the type of firmware installed in the controller using the Firmware Type drop-down menu. 

 

 

 

 

 

If you wish to see the property ID numbers for the standard BACnet properties as well as the proprietary ones, 
select the View Standard BACnet Properties option. 

Click OK and the property ID numbers will then be displayed in the window. 

When you are finished, click Close to close this window. 

 

Property/Object Id Generator 

The Property/Object ID Generator option calculates BACnet property object identifier numbers and 
property identifier numbers from PUP attributes and channels. Device object identifiers can also be 
calculated from the device’s instance number. 

 

 
 

 

Figure 2-42: Property/Object ID Generator 

 

Select the Property/Object ID Generator option from the Utilities menu, or press Ctrl-I, to open the 
Property/Object ID Generator dialog.  

NOTE 

Currently, NB-Pro supports the  ASC and GPC  families of

controllers. The ASC family consists of the NB-ASC, NB-VAV

and the NB-V3T models. The GPC family consists of the NB-

GPC1, NB-GPC2, and NB-GPC3. 
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Figure 2-43: Property/Object ID Generator dialog 

 

From this window you can calculate the property or object ID number for a given object or property for a 
Native Series GPC or ASC controller. 

 

 
 

 

 
 

 

To determine a property ID number, object ID number, or device ID number: 

1. Select the type of controller (GPC or ASC) using the Device Type drop down. 

2. For a property ID, enter the two-letter attribute name into the Attribute field. The property ID will be 
shown to the right of the field in both decimal and hexadecimal. 

3. For a object ID, enter the PUP channel name (i.e. FF00, F901, etc.) into the Channel field. The object ID will 
be shown to the right of the field in both decimal and hexadecimal. 

 

4. For a device ID, enter the device serial number or instance number into the S/N or Instance field. The 
device ID will be shown to the right of the field in both decimal and hexadecimal. 

5. When you are done, click Close to exit the Property/Object ID Generator dialog. 

  

NOTE 

The decimal and hexadecimal values displayed in the

Property/Object ID Generator can be copied and pasted where

they are need, for example, in an SPL program. 
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Viewer Utilities 

TREND VIEWER 

 

 

Figure 2-44 Trend Viewer 

 

Selecting the Trend Viewer option or pressing Ctrl-T brings up the Trend Viewer dialog: 

 

Figure 2-45 Trend Viewer Window 

This window allows users to plot the values of up to eight (8) controller parameters. The plotted values 
can be updated as frequently as once every two seconds. This can be especially useful for monitoring 
general system performance or when doing such things as tuning PID loops. 
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 TREND VIEWER TOOLBAR 

 

 

 

The Toolbar provides convenient access to a number of commonly used features of the Trend Viewer. From 
here you can select the tools for adjusting the portion of the plot window that is displayed, bring up plot 
preferences, as well as copy, save and print the plot. The Trend viewer toolbar has the following buttons: 

 

 

    Scroll (Axes) - The Scroll (Axes) button is used to manually adjust the portion of the axis that is visible 

without changing the scaling. To scroll an axis in the Plot Window, select the Scroll (Axes) button and click on 
either the x- or y-axis of the plot. While still holding the mouse button, you can drag the axes to change the 
portion that is displayed. 

 

    Zoom (Axes) - The Zoom (Axes) button is used to change the scaling on the axes.  Clicking on the x-axis 

and dragging to the left will zoom out, increasing the amount of the plot that is visible, while dragging to the 
right will zoom in, decreasing the amount of the plot that is visible. Similarly, clicking on the y-axis and dragging 
down will zoom out, increase the amount of the plot that is visible, while dragging up will zoom in, decreasing the 
amount of the plot that is visible. 

 

    Zoom Out All Axes - Clicking the Zoom Out All Axes button will double the amount the axes visible in the 

plot window, keeping the center of  the axes the same.  For example, if the x- and y- axes both ranged from 0 
to 100, clicking the Zoom Out All Axes button would change them to a range of -50 to 150. 

 

    Zoom In All Axes - Clicking the Zoom In All Axes button will halve the amount the axes visible in the plot 

window, keeping the center of the axes the same. For example, if the x- and y-axes both ranged from 0 to 100, 
clicking the Zoom Out All Axes button would change them to a range of 25 to 75. 

 

    Zoom Box - The Zoom Box button is used to manually select an area of the plot and scale it to fill the Plot 

Window. The x- and y-axes will be scaled independently to fit the selected area to fill the Plot Window. 

 

    Cursor - Pressing the Cursor brings up a tool that can be used to view the data values shown in the plot. 

The default setting is to show the x- and y-values for the data point. In this mode a vertical line is displayed which 
can be moved to display the data values for the data point intersected by the vertical line. 

By right clicking on the cursor line, you can change the Style to alternately display only the x-value, or only the y-
value of the data point. There are also Style options to display a period, peak to peak value, or frequency. When 
one of these options are chosen, two lines will be displayed along with a measurement of the distance between 
them. 
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By right clicking on the cursor line, you can also use the Channel option to select which point to measure 
when multiple points are being trended at the same time. 

 

 Properties - The Properties button brings up the Plot options window which allows you to change the 

settings for many aspects of the plot. 

 

 Copy to Clipboard - Copies the contents of the Plot Window to the clipboard. 

 

 Save to File - Saves the content of the Plot Window as a bitmap (.bmp) graphics file. 

 

 Print - Sends the contents of the Plot Window to the printer. 

 

 
 

 TREND VIEWER PLOT WINDOW 

 

 

Figure 2-46 Plot Window 

 

The Plot window is the main area of the Trend Viewer and is used to graphically display the trend data, the legend 

information, and the x- and y-axes. By right-clicking on an object in the plot, a window will be displayed 

which lets you set a number of preferences for the object clicked on. 
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 TREND POINT SELECTION 

 

 

Figure 2-47 Point Selection Tabs 

 

The Point Selection tabs are used to define which values will be trended in the plot window. You must select 
the device, object and property corresponding to each point that you wish to trend. 

 

 

Clicking the Device drop down menu will show a list of all controllers to which NB-Pro is currently 
connected. You can choose any of the controllers by selecting it from the drop down menu. Once the Device 
has been chosen, the Object drop down menu will be populated with a list of all the objects present in that 
device. Select the object associated with the desired property by selecting it from the drop down menu. 
Finally, the property to be trended is selected using the Property drop down menu. As you make your 
selections, the Point Name, located below the row of drop down menus will be populated with the values 
you choose. This point name will be the label used in the Legend of the plot. 

 

The Point Selection tabs can also be used to select bitmap properties. When you select a property that is 
bitmap, and additional drop down menu labeled Bitmap will be displayed just below the Property drop down.  

 

 

Figure 2-48 Selecting a Bitmap Property in the Point Selection Tabs 

Using this menu, you can select which bit of the bitmap property you wish to trend. 
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Modifying Trend Point Values 

 

The point selection tabs can also be used to adjust the values of properties without leaving the Trend 
Viewer. This is needed because the trend data is not saved and, if the window is closed, all previous trend 
information will be lost. Because of this, you have the ability to change values from within the trend viewer. this 
can be used, for example, to adjust loop PID parameters while watching the input and output values in the plot 
window. To edit a property’s value, you must choose the device, object and property just as you would if you 
were trending the value. Then you enter the new value into the Change to Value field located in the lower 
portion of the point selection tab. Once the value has been entered, click the Update Value button to change 
the value of the chosen property. 

 TREND POINT VALUE DISPLAY 

 

 

Figure 2-49 Trend Point Values Window 

 

The Trend Point Values window provides a convenient place to view the current values of the points being 
plotted in the plot window. Each point is listed in the left hand column and the value of that point is 
displayed in the column to the right. 

 CONFIGURING TRENDING 

To configure the Trend Viewer to plot the values of one or more properties, you must first choose the points to 
be plotted, set the refresh interval for the plot, and start the trend. To configure and start a trend, you must 
perform the following steps: 

1. For each point you wish to include in the trend, select the device, object, and property in the point 
selection tabs. The Trend Viewer can be configured to plot up to 8 points simultaneously. Each value 
to be trended must be entered into a different point tab. 

2. Using the Update Every field you can set the interval between updates in the Trend Viewer.  

 

Figure 2-50 Trend Update Interval 

The drop down menu allows you to select whether the value you entered is measured in minutes 
or seconds. If the interval is measured in seconds, the minimum refresh interval is 2 seconds. If the 
interval is measured in minutes, the minimum refresh interval is 1 minute. 

3. Once the trend points have been selected and the update interval set, you must click the Trend 
button to begin trending the data. The trend will continue to update until you press the Stop 
Trending button or you close the Trend Viewer window. 
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ALARM VIEWER 

 

 

Figure 2-51 Alarm Viewer 

 

Selecting the Alarm Viewer option or pressing CTRL-K brings up the Alarms dialog: 

 

Figure 2-52 Alarms Viewer Window 

 

While this window is open, you can view the details of broadcast BACnet alarms. 

If the Alarm Viewer window is not open when an alarm is received, a balloon will appear in the toolbar 
indicating the number of unviewed alarms. 

 

 

Figure 2-53 Alarm Balloon Notification 

 

In the Alarm Viewer, each alarm is listed on its own line. Each column corresponds to a property of the alarm 
listing. The alarm properties are: 

 

Device - The ID number (MAC address) of the device which generated the alarm. 
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Object ID - The type of object and instance which generated the alarm.  The possible object types are listed 
in Table 2-3. 

 

 

Table 2-3 : Object IDs 
 

Object ID Type 

0 Analog Input 

1 Analog Output 

2 Analog Value 

3 Binary Input 

4 Binary Output 

5 Binary Value 

6 Calendar 

7 Command 

8 Device 

9 Event Enrollment 

10 File 

11 Group 

12 Loop 

13 Multi State Input 

14 Multi State Output 

15 Notification Class 

16 Program 

17 Schedule 

18 Averaging 

19 Multistate Value 

20 Trend Log 

> 20 Proprietary 

 

Time Stamp - The time when the alarm was generated. 

Notification Class - The number of the notification class through which the alarm was sent. 

Priority - This is the priority array level associated with the alarm. 
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Event Type - The kind of alarm that is received. A list of the possible types of alarms is given in Table 2-4. 

 

 

Table 2-4 : Event Types 
 

Value Event Type 

0 Change of Bitstring 

1 Change of State 

2 Change of Value 

3 Command Failure 

4 Floating Limit 

5 Out of Range 

6 Complex Event Type 

7 Buffer Ready 

8 Change of Life Safety 

 
 

Notify  Type  -  Displays  whether  the  alarm  that  was  received  was  an  alarm,  an  event,  or  an 

acknowledgement notification. The different notify types are listed in Table 2-5 

 

 

Table 2-5 : Notify Type Types 
 

Value Notify Type 

0 Alarm 

1 Event 

2 Ack-Notification 

 

 

Ack Required - Indicates whether or not this alarm needs to be acknowledged. 

  



 
 
 

60 © American Auto-Matrix MAN0122US  Rev 5 

M
A

N
0

1
2

2
U

S  R
ev 5

 

From State - Displays the state before the alarm was sent. The state listed is not the actual state of the 
property, but the BACnetEventState value. The possible From State values and the states associated with them 
are listed in Table 2-6 

 

 

Table 2-6 : From State Values 
 

From State 

Value 

 

State 

0 Normal 

1 Fault 

2 Offnormal 

3 High Limit 

4 Low Limit 

5 Life-Safety Alarm 

 

 

To State - Displays the state of the property after the change that generated the alarm. Like the From 
State, the state listed is not the actual state of the property, but the BACnetEventState value. The values for 
the To State are the same as the From State listed in Table 2-6. 

 

 

 

Event Value - Displays the values for high- and low-limit alarms, the value, the deadband, the status flag 
bitmap, and the limit will be displayed. 
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BACNET ERROR VIEWER 

 

 

Figure 2-54 BACnet Error Viewer 

 

Selecting the BACnet Error Viewer option from the Utilities menu or pressing Ctrl-N brings up the BACnet Error 
Viewer window.  

 

Figure 2-55: BACnet Error Viewer Window 

 

Upon opening the error viewer, all errors received since opening NB-Pro will be displayed. 

 

If the viewer is open when a BACnet error message is received, errors will automatically be displayed in the 
viewer as soon as they are received. 

 

Each error displayed in the BACnet Error Viewer window has the following properties: Time Stamp - This 
indicates the time at which the error occurred. 

Device - The ID number of the device from which the error was received. 
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NAK Type - This is the type of error received. The NAK types are listed in Table 2-7. 

Table 2-7 : NAK Types 
 

NAK Type Meaning 

 

Error PDU 
Used to communicate errors that occur during 

specific operations between BACnet entities 

 
Abort PDU 

Used to terminate transactions between BACnet 

devices. 

 

 
Reject PDU 

Used to communicate the rejection of a confirmed 

request based on inconsistencies with the message 

sent or protocol errors that prevent the request from 

being carried out. 

 

 

NAK Reason - The NAK Reason columns gives a description of why the error occurred. Table 2-8 lists all the 

possible NAK Reasons. 

 

 

Table 2-8 : NAK Reason 
 

Nak Reason Vale Meaning 

 
Other 

 
0 

An error has occurred that does not match any other error 

type. 

 
Authentication Failed 

 
1 

The message being authenticated was not generated by the 

apparent service provider. 

 
Configuration In 

Progress 

 

2 

The service request has been declined because the 

addressed device is in the process of being configured, 

either locally or by means of other protocol services. 

 

 
Device Busy 

 

 
3 

A service request has been declined because the 

addressed device expects to be involved in higher priority 

processing for an amount of time in excess of the usual 

request/confirm timeout period. 

Dynamic Creation Not 

Supported 

 
4 

An attempt has been made to create an object of a type that 

cannot be created dynamically. 

 

File Access Denied 

 

5 

An AtomicReadFile or AtomicWriteFile service request has 

been made to access a file that is currently locked or 

otherwise not accessible. 

Incompatible Security 

Levels 

 
6 

The two clients do not have the same security authorization 

level. 

Inconsistent 

Parameters 

 
7 

A conflict exists in the parameters specified in the service 

request. 
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Table 2-8 : NAK Reason 
 

Nak Reason Vale Meaning 

 

Inconsistent Selection 

Criterion 

 

8 

A reference has been made to a property using a datatype 

which is inconsistent with the 'Comparison Value' specified in 

an 'Object Selection Criteria' service parameter. 

 

Invalid Data Type 

 

9 

The datatype of a property value specified in a service 

parameter does not match that of the property referenced by 

the Property_Identifier. 

 
Invalid File Access 

Method 

 

10 

Generated in response to an AtomicReadFile or 

AtomicWriteFile request that specifies a 'File Access 

Method' that is not valid for the specified file. 

 
Invalid File Start 

Position 

 

11 

An AtomicReadFile or AtomicWriteFile request has specified 

an invalid 'File Start Position' or invalid 'File Start Record' 

parameter. 

Invalid Operator Name 12 The 'Operator Name' does not match any known operators. 

Invalid Parameter 

Datatype 

 
13 

The datatype of a value specified for a service parameter is 

not appropriate to the parameter. 

 

 
Invalid Time Stamp 

 

 
14 

The 'Time Stamp' parameter conveyed by an 

AcknowledgeAlarm service request does not match the time 

of the most recent occurrence of the event being 

acknowledged. 

 
Key Generation Error 

 
15 

The key server was unable to generate a Session Key for 

the request. 

Missing Required 

Parameter 

 
16 

A parameter required for the execution of a request was not 

supplied. 

No Objects Of Specified 

Type 

 
17 

The device's object database has no objects of the object 

type specified in the service request. 

 
No Space For Object 

 
18 

An attempt to create an object has failed because not 

enough dynamic memory space exists in the device. 

 
No Space To Add List 

Element 

 

19 

An attempt to add an element to a list has failed because 

there is insufficient dynamic memory space in the addressed 

device. 

No Space To Write 

Property 

 
20 

An attempt to write a property has failed because there is 

insufficient dynamic memory space in the addressed device. 

No VT Sessions 

Available 

 
21 

This error indicates that the target device could not fulfill a 

VT-Open request because of resource limitations. 

 

Property Is Not A List 

 

22 

An AddListElement service or the RemoveListElement 

service request has been made of a property that does not 

have a list datatype. 
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Table 2-8 : NAK Reason 
 

Nak Reason Vale Meaning 

Object Deletion Not 

Permitted 

 

23 
An attempt has been made to delete an object that cannot 

be deleted. 

Object Identifier Already 

Exists 

 
24 

An attempt has been made to create a new object using an 

object identifier that is already in use. 

 

Operational Problem 

 

25 

The service request has been declined because the 

addressed device has detected a problem that prevents it 

from carrying out the requested service. 

 
Password Failure 

 
26 

The 'Operator Password' did not match the value associated 

with the 'Operator Name'. 

 
Read Access Denied 

 
27 

An attempt has been made to read the properties of an 

object defined as inaccessible. 

 
Security Not Supported 

 
28 

The remote client does not support any BACnet security 

mechanisms. 

Service Request 

Denied 

 
29 

The requesting device does not have the appropriate 

authorization to execute the requested service. 

 
Timeout 

 
30 

The APDU with the expected Invoke ID was not received 

before the waiting time expired. 

 
Unknown Object 

 
31 

The object_identifier which has been specified does not exist 

in the object database of the addressed device. 

 
Unknown VT Class 

 
34 

The 'VT-Class' specified in a VT-Open request was not 

recognized by the target device. 

 
Unknown VT Session 

 
35 

The 'VT-Session ID' specified in a VT-Data or VT-Close 

request was not recognized by the target device. 

Unsupported Object 

Type 

 
36 

An object type has been specified that is unknown or 

unsupported in the addressed device. 

 
Value Out Of Range 

 
37 

An attempt has been made to write to a property with a value 

that is outside the range of values allowed for the property. 

VT Session Already 

Closed 

 
38 

An attempt has been made to close a VT-session that has 

been previously terminated. 

 
VT Session Termination 

Failure 

 

39 

One of the 'VT-Sessions' specified in a VT-Close request 

could not be released for some implementation-dependent 

reason. 

 
Write Access Denied 

 
40 

An attempt has been made to write to a property of an object 

defined as inaccessible. 

Character Set Not 

Supported 

 
41 

A character string value was encountered that is not part of a 

supported character set. 

 



 
 
 

MAN0122US  Rev 5 © American Auto-Matrix 65 

 

Table 2-8 : NAK Reason 
 

Nak Reason Vale Meaning 

 

Invalid Array Index 

 

42 
An attempt was made to access an array index that is 

outside the range permitted for this array. 

COV Subscription 

Failed 

 
43 

 
The subscription to the change of value service has failed. 

Not COV Property 44 The property specified does not support COV notification. 

 
Optional Functionality 

Not Supported 

 

45 

An attempt has been made to write a value to a property that 

would require the device to exhibit optional functionality 

which is not supported. 

Invalid Configuration 

Data 

 
46 

The configuration data provided with the service request was 

invalid or corrupt. 

 

 

When you are done viewing the errors, you can manually clear individual errors or clear all errors 
displayed by clicking the Delete NAK or Clear All NAK buttons respectively. Closing the BACnet Error Viewer 
will clear all displayed errors. 
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Capture Menu 

Using NB-Pro’s Capture feature, users can capture all property values of a particular device. Users can then 

save captured data to a .cap file on their PC. The .cap format generated by NB-Pro is a standard text-based 
format, which allows users to easily modify values of a controller offline, or serve as a template for multiple 
controllers. Captures can then be downloaded back directly to devices. 

 

Capture File Generation 

To capture the values of a device, perform the following procedure: 

 

1. Click on Capture on the NB-Pro menu bar or press Ctrl-J. 

  

 

Figure 2-56 Capture File Generation 

 

 

2. Highlight then click on Capture File Generation. The Capture window will appear. 

3. Click on the down arrow in the Device field and select the device whose values you wish to capture from 
the drop-down box. 

4. If you wish to capture all of the properties in the device, select the Capture all Properties box. Otherwise, 
only the writable properties will be written to the capture file. For controllers which support 
ReadPropertyMultiple, all properties will always be captured. 

 

 

 
 

NOTE 

Capturing all properties in a controller can significantly

increase the time needed to capture the controller and,

subsequently, download the capture file to a controller at a

later time. This option is usually only needed when generating

a report. 
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5. If you wish to immediately generate a report of the capture file, select the Generate Report box. You may 
also choose launch the report generator by selecting the Generate Report button. 

6. Click on the Capture button. The progress will be displayed using the two green bars in the middle of the 
screen. As properties from an object are captured, the detail will be displayed in the lower window and the 

lower progress bar will increment. When NB-Pro begins capturing an object, the name of the object will 
be listed in the upper window. When the object is captured, the upper progress bar will increment and the 
name of the next object will be added to the upper window. 

 

 

Figure 2-57: Capturing Device Property Values 

 

7. A dialog box will appear once the capture is completed. Click on the OK button in the Capture Completed 
dialog box 

 

Figure 2-58: Capture Completed 

 

8. Click the Save button. You will then be prompted to choose the location where you wish to save your 
report, as a .xml file, on your PC’s hard disk drive. If you selected the Generate Report option, you will see 
a dialog asking you if you would like to view the report. If you click on Yes the report will be displayed 

using Internet Explorer. 
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Figure 2-59: View Report? dialog 

 

 

9. If, for some reason, the capture is not successful you may try to capture the device again using the Retry 
button. 

10. When you are finished capturing devices, press the Close button to exit from the capture window. 

 

Download Capture File 

 

Figure 2-60: Download Capture File 

The Download Capture File option is used to write property values stored in a capture file to NB-ASC and NB-
VAV devices. If you wish to download a capture file to an NB-GPC controller, see see Error! Reference 
source not found. on page Error! Bookmark not defined.. 

1. Click on Capture on the NB-Pro menu bar and highlight then click on Download Capture File or press 
Ctrl-D. The Download to Unit(s) dialog will be displayed: 
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Figure 2-61: Download to Device(s) 

2. Click on the Load File button. 

3. Browse to the location of the capture file you wish to load to another device (or devices) and click on 
the Open button in the Open Capture File window. The Download to unit(s) window will appear. 
The characteristics of the capture file will appear in the lower portion of the Download to unit(s) 
dialog. 

4. Select (click on) the device(s) to which you wish to download the capture file from the Devices field. 

5. Click on the Download button. The status of the download is indicated in the status indicator located 
to the left of the Load File button. The Download Complete dialog box will appear upon completion 
of the download process. 

Download Capture File To GPC 

 

Figure 2-62: Download Capture File to GPC 

Click on Capture on the NB-Pro menu bar and highlight then click on Download Capture File to GPC or press Ctrl-
G. The Download Capture File to GPC window will open: 
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Figure 2-63: Download Capture File to GPC window 

A list of available controllers will be shown in the box to the right of the Capture Information pane. 

Click on the Load File button. 

The information about the capture file, including the controller type and firmware version will be displayed in 
the Capture Information pane. 

Browse to the location of the capture file you wish to load to another device (or devices) and click on the Open 
button in the Open Capture File window. The Download Capture File to GPC dialog will appear. The 
characteristics of the capture file will appear in the panes in the lower portion of the Download Capture File to 
GPC dialog. 

Select (click on) the device(s) to which you wish to download the capture file from the filed to the right of the 
Capture Information pane. 

If you wish to disable the download of alarm settings, GID assignments, property values, sensor type, out-of-
service information, or object names that should be done now. For more information, see Disabling Download 
Information on page 71. 

Click on the Download button. 

The download complete dialog will appear. 

 

Figure 2-64 

Click on OK. 
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Disabling Download Information 

When downloading a capture file to a GPC controller, you have the option of downloading the alarm 
settings, GID assignments, property values, sensor type information, out-of-service settings, and object 
names. You can also disable the download of “All Other Properties” which will decrease the time needed if you 
are only interested in downloading specific information from one of the other categories. By default, all of 
these types of information will be downloaded. If you do not wish to download a particular type of 
information, you must specifically disable that type of download. 

To disable the download of alarming information: 

1. Click on the Alarms tab. 

 
Figure 2-65: Alarms tab 

2. Make sure that the Alarming box is unchecked. 

3. Disable any other information types you do not wish to download or proceed with the download. 

To disable the download of GID number assignments: 

1. Click on the GIDs tab. 

 
Figure 2-66: GIDs tab 

2. Make sure that the GIDs box is unchecked. 

3. Disable any other information types you do not wish to download or proceed with the download. 
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To disable the download of properties not specifically addressed by another option: 

1. Click on the All Other Properties . 

 
Figure 2-67: All Other Properties tab 

2. Make sure that the Properties box is unchecked. 

3. Disable any other information types you do not wish to download or proceed with the download. 

 

To disable the download of sensor type information: 

1. Click on the Sensor Type tab. 

 
Figure 2-68: Sensor Type tab 

2. Make sure that the Sensor Types box is unchecked. 

3. Disable any other information types you do not wish to download or proceed with the download. 

 

To disable the download of the out-of-service settings: 
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1. Click on the out-of-service tab. 

 
Figure 2-69 out-of-service tab 

2. Make sure that the out-of-service box is unchecked. 

3. Disable any other information types you do not wish to download or proceed with the download. 

 

 

To disable the download of the object names: 

1. Click on the object-name tab. 

 
Figure 2-70 object-name tab 

2. Make sure that the object-name box is unchecked. 

3. Disable any other information types you do not wish to download or proceed with the download. 
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SPL Menu 

Open SPL File 

 

Figure 2-71 Open SPL File 

 

The Open SPL File option is used to browse for a text file containing SPL code. Selecting this option will bring up 
a standard Windows file browser which you use to select the file you wish to open. Once the file is selected, it 

will be opened in the SPL Editor. 

 

SPL Editor 

 

 

Figure 2-72 SPL Editor 

 

Selecting the SPL Editor Option will launch the SPL Editor if it is not already running and switch to that 

application. For More information on the SPL Editor, see The SPL Editor on page 78. 
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Help Menu 

About 

 

Figure 2-73 About 

Selecting the About option under the Help menu or pressing Ctrl-B brings up the NB-Pro splash screen 

which will show the current version number of the NB-Pro software and the site name, serial number and 
expiration date read from the USB licence key. 

Icon Help 

 

Figure 2-74 Icon Help 

When using NB-Pro, you may encounter some of the following icons. Selecting the Icon Help option under the 

Help menu or pressing Ctrl-H brings up the Icon Help dialog, which displays the icons found in NB-Pro, and 
their meaning. 

 

Figure 2-75: NB-Pro Icons 





 
 

 

 

SECTION 3 :  THE SPL EDITOR 
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This section describes the functionality of the SPL Editor software package and includes descriptions of all the 

menus and toolbar options available. The use of the SPL Editor will also be discussed. 

 

The SPL Editor 

Selecting the SPL Editor option from the Utilities menu in NB-Pro will launch the SPL Editor if it is not 
already running and switch to the window shown below: 

 

 

Figure 3-1: SPL Editor Window 
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File Menu 

The File menu is used to open and close documents in the SPL Editor as well as configure the printer and print 
documents. 

 

 

Figure 3-2 File Menu 

 

New... - Opens a new, untitled SPL document in the SPL Editor. 

 

Open... - Opens an SPL document which has been previously saved. 

 

Close - Closes the current SPL document.  If changes have been made since the document was last saved, 
you will be asked if you want to save those changes. 

 

Save - Saves the current file.  If the file is new and has not been saved, a file browser window will be 
opened and you will be prompted to choose a location and filename for the program. 

 

Save As... - Saves the current file with a different filename. A file browser window will be opened and you will 
be prompted to choose a location and filename for the program. 

 

Print... - Prints the current SPL document. 

 

Printer Color/Font Selection... - Allows you to specify options for the automatic color coding of text in an 

SPL document to be used when the file is printed. 

 
 

NOTE 

The colors selected with the Printer Color/Font Selection...

options can be different from those for display on the screen

specified using the Utilities>Select font/colors... option 
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Figure 3-3 Printer color/font setup 

 

 

To set the SPL Editor to automatically color code text for printing, perform the following steps: 

 

1. Select Printer Color/Font Selection... from the File menu. 

2. Click the Enable syntax highlighting checkbox. 

 

To change the way in which a type of text is printed, perform the following steps: 

 

1. Select Printer Color/Font Selection... from the File menu. 

2. Choose the type of item you wish to change the coloring for by selecting it in the Select Item drop 
down list. 

3. Choose the specific item to apply the coloring to by selecting it in the See what it applies to: drop 
down. 

4. Click the Change... button. 

5. Choose the desired color and click OK. 

6. If you wish to change the font used for that type of item, click the Font... button and choose the 
desired font, style, and size. 

7. When you are finished setting all you desired color choices, click OK. 

Print Setup - Opens the standard Windows Print Setup dialog where you may specify the options for your 
printer. 

Exit - Closes the SPL Editor application. 
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Edit Menu 

The Edit menu provides many functions for manipulating text when writing SPL programs. 

 

 

Figure 3-4 Edit Menu 

 

Undo - Erases any changes made by the last action and resets the text to the state before that action was 
performed. 

Redo - Performs the last action that was undone. 

Cut - Removes the currently selected text from the active SPL document and stores it so that it may be 
pasted at a later time. 

Copy - Stores the currently selected text from the active SPL document without deleting it. 

Paste - Copies the previously cut or copied text into the currently active SPL document at the insertion 
point. 

Delete - Removes the currently selected text from the active SPL document but does not store the deleted text. 
If text is deleted, it may not be pasted at a later time. 

 

 
 

Select All - Selects all text in the active SPL document. 

Next Error - Moves the insertion point forward to the next error found in the currently active SPL 
document. 

Previous Error - Moves the insertion point backwards to the previous error found in the currently active SPL 
document. 

NOTE 

The Find and Replace options do not function in the current

release of the SPL Editor. 
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View Menu 

The View menu is used to control which toolbars are displayed.  You can also reapply the selected text 
highlighting with the Re-highlight option. 

 
 

 

Figure 3-5 View Menu 

 

 

Toolbar - Toggles visibility for the toolbar in the SPL Editor window.  

Status Bar - Toggles visibility for the status bar in the SPL Editor window.  

Rehighlight - Redraws the screen, applying any relevant highlighting. 
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Utilities Menu 

The Utilities menu allows you to compile and decompile SPL source code.  The options display and file 
storage are also set in this menu. 

 
 

 

Figure 3-6 Utilities Menu 

 

 

 

 
 

 

Compile - Compiles the code in the currently active SPL document and saves the resulting PLB and LST files 
according to the options set in the Preferences. 

 

Decompile - Decompiles the current PLB file.  Decompiling a PLB file will result in the creation of SPL code 

 

 

 
 

 

Select font/colors... - Allows you to specify options for the automatic color coding of text in an SPL 
document to be used when the displaying the file on the screen. 

 

 
 

 

 

NOTE 

The Download/upload option is disabled in this release of the

SPL Editor and cannot be selected. 

NOTE 

The Sole Master option is disabled in this release of the SPL

Editor and cannot be selected. 

NOTE 

The colors selected with the Select font/colors... options can

be different from those for display on the screen specified

using the File>Printer Color/Font Selection... option 
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Figure 3-7 Screen color/font setup Window 

 

To set the SPL Editor to automatically color code text for viewing, perform the following steps: 

 

1. Select Select Font/Color... from the Utilities menu. 

2. Click the Enable syntax highlighting checkbox. 

 

To change the way in which a type of text is displayed, perform the following steps: 

 

1. Select Select Font/Color... from the Utilities menu. 

2. Choose the type of item you wish to change the coloring for by selecting it in the Select Item drop 
down list. 

3. Choose the specific item to apply the coloring to by selecting it in the See what it applies to: drop 
down. 

4. Click the Change... button. 

5. Choose the desired color and click OK. 

6. If you wish to change the font used for that type of item, click the Font... button and choose the 
desired font, style, and size. 

7. When you are finished setting all you desired color choices, click OK. 

 

Preferences... - This opens the Directories window shown in Figure 3-8. Here is where you specify how 

the SPL Editor handles PLB and LST files which it generates. You may also specify how hexadecimal 
numbers are handled. 

 

 

 
 



 
 
 

MAN0122US  Rev 5 © American Auto-Matrix 85 

 

Figure 3-8: Directories Window 

 

 

PLB File output 

Place in Source directory - When this option is selected, compiled PLB files will be saved in the directory which 
contains the source code. 

 

Place in a directory Relative to source directory - This option allows you to save the PLB file into a 
subdirectory which you specify. A subdirectory located in the same directory as the source file is specified by 
entering the name of the subdirectory, starting from the source directory and separating any further 
subdirectories with the “\” character, into the field below this option. If you wish to save the PLB file in a 
directory one or more levels above the directory which contains the source file, you may enter “..\” into the 
field to indicate a level up from the directory of the current directory. The “..\” term may be used multiple 
times to indicate multiple levels above that of the source file. 

 

Place in specific Directory - When this option is selected, the compiled PLB files will be saved in the 
directory shown in the field immediately below this option. Clicking the “...” button next to the field opens a 
folder browser which lets you select the desired folder. 
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LST File output 

None - When this option is selected, no LST file will be generated. 

 

Place in Source directory - When this option is selected, LST files will be saved in the directory which contains 
the source code. 

 

Use Same output spec as PLB file - When this option is selected, LST files will be saved to the location 

specified in the PLB File output pane. 

 

Place in a directory Relative to source directory - This option allows you to save the LST file into a 
subdirectory which you specify. A subdirectory located in the same directory as the source file is specified by 
entering the name of the subdirectory, starting from the source directory and separating any further 
subdirectories with the “\” character, into the field below this option. If you wish to save the LST file in a 
directory one or more levels above the directory which contains the source file, you may enter “..\” into the 
field to indicate a level up from the directory of the current directory. The “..\” term may be used multiple 
times to indicate multiple levels above that of the source file. 

 

Place in specific Directory - When this option is selected, the LST file will be saved in the directory shown 
in the field immediately below this option. Clicking the “...” button next to the field opens a folder browser 
which lets you select the desired folder. 

 

Decompiler Options (defaults) 

Hex numbers - These options specify how you wish for hexadecimal numbers to be displayed. 

 

Show Hex offsets - If this option is checked, the hexadecimal offsets will be displayed in the decompiled SPL 
code. These addresses can be useful for debugging. 

 

 

 
 

 

Show Labels on separate line - If this option is checked, the SPL Editor will display the tab after a program 
label as a carriage return. This will cause any SPL code following the label to be displayed on the next line.    

 

NOTE 

With  this  option  checked,  the  decompiled  file  cannot  be

compiled until the hex offset information is removed. 
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Window Menu 

 

 

Figure 3-9 Window Menu 

 

Cascade - Arranges all the open SPL documents such that the title bar of the first window is at the upper 

leftmost corner of the SPL Editor window and each other window is offset downwards and to the right of 
the one above it in such a way as to have all the title bars visible, but the windows overlapping. 

 

Tile - Arranges all the open SPL document windows so that each takes up an equal amount of space in the 

main SPL Editor window and does not overlap with another document window. 

 

Arrange Icons - Arranges all minimized windows along the bottom of the screen. 

 

A List of currently open SPL documents will be shown below the divider underneath the Arrange Icons 
option. 

Help Menu 

 

Figure 3-10 Help Menu 

 

Help Topics 

 

 

About SPL Editor... - Brings up the About SPL Editor window which displays the copyright information for the 

SPL Editor as well as the version number, registration information and a listing of your system 
configuration. 

NOTE 

The Help Topics option is disabled in this release of the SPL

Editor and does not function correctly. 
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Toolbar 

The toolbar in the SPL Editor provides quick access to many of the most commonly used features and 
functions of the program. The toolbar may be hidden using the View:Toolbar option. 

 
 

 

Figure 3-11: SPL Editor Toolbar 

 

The SPL Editor toolbar is shown in Figure 3-11. The buttons have the following functions: 

 

 New - Creates a blank SPL document in the SPL Editor. 

 Open – Opens a browser to select an SPL file to open in the SPL Editor. 

 Save - Opens a browser to select where to save the currently active file in the SPL Editor.  If the file 
already exists in this location, this will save over the previous copy. 

 Print - Prints the currently active file in the SPL Editor. 

 Cut - Removes the highlighted text from the currently active file in the SPL   Editor.  

 Copy - Copies the highlighted text from the currently active file in the SPL Editor.  

 Paste - Copies the contents of the clipboard into the current file at the insertion point.  

 About - Brings up the About SPL dialog box. 

  SPL Compiler - Compiles the current file. 

Next Error - Jumps forward to the next error found in the current file.  

 Previous Error - Jumps backwards to the first error before error. 

 Decompile - Decompiles the current PLB file to an SPL document. 
 

 

 

 



 
 

 

SECTION 4 :  APPENDIX A:  
STANDARD OBJECT AND PROPERTY 
IDENTIFIERS 
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This section contains the BACnet Identifier numbers for all standard objects and properties. These values are 

needed when using the Manual Read/Write option in NB-Pro. 

 

 

 

 

A. 1 Standard BACnet Object Identifier Numbers 

 

 

analog-input 0 

analog-output 1 

analog-value 2 

averaging 18 

binary-input 3 

binary-output 4 

binary-value 5 

calendar 6 

command 7 

device 8 

event-enrollment 9 

file 10 

group 11 

life-safety-point 21 

life-safety-zone 22 

loop 12 

multi-state-input 13 

multi-state-output 14 

multi-state-value 19 

notification-class 15 

program 16 

schedule 17 

trend-log 20 
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A.2 Standard Bacnet Property Identifier Number 
 

acked-transitions 0 

ack-required 1 

action 2 

action-text 3 

active-cov-subscriptions 152 

active-text 4 

active-vt-sessions 5 

alarm-value 6 

alarm-values 7 

all 8 

all-writes-successful 9 

apdu-segment-timeout 10 

apdu-timeout 11 

application-software-version 12 

archive 13 

attempted-samples 124 

average-value 125 

backup-failure-timeout 153 

bias 14 

buffer-size 126 

change-of-state-count 15 

change-of-state-time 16 

client-cov-increment 127 

configuration-files 154 

controlled-variable-reference 19 

controlled-variable-units 20 

controlled-variable-value 21 

cov-increment 22 

cov-resubscription-interval 128 

current-notify-time 129 

database-revision 155 

datelist 23 

daylight-savings-status 24 

deadband 25 

derivative-constant 26 

derivative-constant-units 27 

description 28 

description-of-halt 29 

device-address-binding 30 

device-type 31 

direct-reading 156 

effective-period 32 

elapsed-active-time 33 

error-limit 34 

event-enable 35 

event-parameters 83 

event-state 36 

event-time-stamps 130 

event-type 37 

exception-schedule 38 

fault-values 39 

feedback-value 40 

file-access-method 41 

file-size 42 

file-type 43 

firmware-version 44 

high-limit 45 

inactive-text 46 

in-process 47 

instance-of 48 

integral-constant 49 

integral-constant-units 50 

issue-confirmednotifications 51 

last-restore-time 157 

life-safety-alarm-values 166 

limit-enable 52 

list-of-group-members 53 

list-of-object-property-

references 

54 

list-of-session-keys 55 

local-date 56 

local-time 57 

location 58 

log-buffer 131 

log-device-object-property 132 

log-enable 133 

log-interval 134 

low-limit 59 

maintenance-required 158 

manipulated-variable-

reference 

60 

max-apdu-length-accepted 62 

maximum-output 61 

maximum-value 135 

maximum-value-timestamp 149 

max-info-frames 63 

max-master 64 

max-pres-value 65 



 
 
 

92 © American Auto-Matrix MAN0122US  Rev 5 

M
A

N
0

1
2

2
U

S  R
ev 5

 

max-segments-accepted 167 

member-of 159 

minimum-off-time 66 

minimum-on-time 67 

minimum-output 68 

minimum-value 136 

minimum-value-timestamp 150 

min-pres-value 69 

mode 160 

model-name 70 

modification-date 71 

notification-class 17 

notification-threshold 137 

notify-type 72 

number-of-APDU-retries 73 

number-of-states 74 

object-identifier 75 

object-list 76 

object-name 77 

object-property-reference 78 

object-type 79 

operation-expected 161 

optional 80 

out-of-service 81 

output-units 82 

polarity 84 

present-value 85 

previous-notify-time 138 

priority 86 

priority-array 87 

priority-for-writing 88 

process-identifier 89 

profile-name168  

program-change 90 

program-location 91 

program-state 92 

proportional-constant 93 

proportional-constant-units 94 

protocol-conformance-class 95 

protocol-object-types-

supported 
96 

protocol-revision 139 

protocol-services-supported 97 

protocol-version 98 

read-only 99 

reason-for-halt 100 

recipient 101 

recipient-list 102 

record-count 141 

records-since-notification 140 

reliability 103 

relinquish-default 104 

required 105 

resolution 106 

segmentation-supported 107 

setpoint 108 

setpoint-reference 109 

setting 162 

silenced 163 

start-time 142 

state-text 110 

status-flags 111 

stop-time 143 

stop-when-full 144 

system-status 112 

time-delay 113 

time-of-active-time-reset 114 

time-of-state-count-reset 115 

time-synchronization-

recipients 

116 

total-record-count 145 

tracking-value 164 

units 117 

update-interval 118 

utc-offset 119 

valid-samples 146 

variance-value 151 

vendor-identifier 120 

vendor-name 121 

vt-classes-supported 122 

weekly-schedule 123 

window-interval 147 

window-samples 148 

zone-members 165 

 



 
 

 

 

 

SECTION 5 :  APPENDIX B: TREND 
VIEWER 
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The Trend Viewer has a number of display option which can be used to fine tune the display of your trend data.  

The options window is accessed by clicking on the   button or by right-clicking anywhere in the plot window 

and selecting the Edit... option. Right clicking on a specific object, such as an axis, or the legend, will bring up 
the options specific to that object. This section explains the options associated with the various components of 
the trend. 

Control 

Control>General 

 

 

Figure B-1 Control>General 
Tab 

 

The General sub-tab in the Control tab controls some of the features of how the plot is displayed as well as the 

program’s behavior when copying the plot to the clipboard. The General sub-tab has the following options: 

 

Copy To ClipBoard Format: specifies the image format that will be used when the current plot is copied to the 

clipboard. The format options are Meta File, Bitmap, and JPEG. 

Clip Annotations To Axes: specifies whether annotations clip to the axes they are assigned to or whether they can 

be drawn outside of the axes bounds. This only has a real effect if the associated X- and/or Y-Axis of the annotation 

does not span 100% of the plot window, for example if you are using stacked axes. 

Auto Frame Rate: The Auto Frame Rate button specifies whether the control automatically activates the repaint 

frame rate control. When the Auto Frame Rate is set to true, the control automatically calls BeginUpdate 

when the control is performing its next repaint. From then on, the control repaint frame rate is equal to the 

UpdateFrameRate no matter how many changes are made to the control every second. 

Update Frame Rate: The Update Frame Rate controls the number of times the plot is redrawn per second. 

Border Style: The Border Style option allows you to add a three-dimensional beveled look to the plot window. 

Outer Margin: The Outer Margin option is used to set the margin between the left, right, top, and bottom edge 

of the plot window and the plot itself. The values are specified in pixels. 
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Control>Title 

 

 

Figure B-2 Control>Title Tab 

 

The Title sub-tab in the Control tab allows you to customize the display of your plot’s title. The Title sub- tab 
has the following options: 

Visible: Deselecting this check box will hide the main chart title displayed above the plot. 

Text: This box is used to set the text of the plot title. 

Margin: This value is the number of lines (the same size as the title) that will be used as the margin 
between the bottom of the title and the plot. 

Font: Clicking this button will bring up the dialog shown in Figure B-3. This window can be used to select the 
font family, style, size, and color of the font used for the title.  Additionally, you can apply the strikeout or 
underline effects to the title text. 

 
 

 

Figure B-3 Control>Title Font Window 
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Control>Print 

 

 

Figure B-4 Control>Print tab 

 

The Print sub-tab in the Control tab allows you to specify options used when printing the plot.  The Print sub-
tab has the following options: 

 

Show Dialog: This button specifies whether or not the printer setup dialog is shown when the plot is 
printed. 

 

Orientation: Sets the orientation of the plot when it is printed. 

 

Margin: Specifies the left, right, top, and bottom margins on the printed page. 

 

Document Name: Used to set the document name displayed on some printer displays when the 
document is being printed. 
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Control>Hints 

 

 

Figure B-5 Control>Hints sub-tab 

 

The Hints sub-tab in the Control tab specifies the behavior of the pop-up tips associated with the button in 

the Trend Viewer. The Hints sub-tab has the following options: 

 

 

Show: Specifies whether or not pop-up tool tips are shown. 

 

Pause: Sets the time, in milliseconds, that the user must hold the mouse over a certain object before the tool tip 

is displayed. 

 

Hide Pause: Sets the time, in milliseconds, that must elapse before a display tool tip is erased. 
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Control>File I/O 

 

 

Figure B-6 Control>File I/O Tab 

 

The File I/O sub-tab in the General tab is used to control the Trend Viewer’s ability to save logged data to a text 

file for future use. The File I/O sub-tab has the following options: 

 

Log File Name: Sets the filename (including path) for the log file. Pressing the button allows you to specify the 

location of the log file on your computer. By entering a filename into the “File Name:” field, a new .log file will be 

created. 

 

Log Buffer Size: Used to set the size of the log buffer, in number of data points. When trending is active, data will 

flow into the log buffer. When the buffer is filled, the data will be written to the log file and the buffer cleared. 

This is useful if you want to regulate how often data is written to the log file. If this value is 0, then data is written to 

the log file after every new data point is added to the chart. 

 

Properties Save/Load: Used to save or load the preferences for the plot. 

 

Data Save/Load: Used to save or load the data points from the plot. 

 

Annotations Save/Load: Used to save or load the annotations for the plot. 

  



 
 
 

MAN0122US  Rev 5 © American Auto-Matrix 99 

Control>Annotation Defaults 

 

 

Figure B-7 Control>Annotation Defaults Tab 

 

The Annotation Defaults sub-tab in the General tab is used to define the styles used for annotations added to 

the plot. The Annotation Defaults sub-tab has the following options: 

Font: Clicking this button will bring up the dialog shown in Figure B-8. This window can be used to select the 

font family, style, size, and color of the font used for the title.  Additionally, you can apply the strikeout or 

underline effects to the title text. 

 

 

Figure B-8 Control>Annotation Font Window 

Pen Color: Specifies the pen color used when drawing the annotation object. Pressing the button will bring 

up the color window shown in Figure B-9. 
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Figure B-9 Color Picker 

 

Using this window, you can select the color of the line drawn from the Basic Colors or you can define a custom 

color. By clicking the “Define Custom Color>>” button, the color picker shown in Figure B-10 will be displayed. 

 
 

 

Figure B-10 Define Custom Color 

 

First select the Custom Color block you wish to define and then select the desired color by moving the cross-

hairs cursor in the color block. The slider on the right hand side varies from white to the chosen color to black 

to allow you to select the desired shade of your color. Alternately, you can directly enter the Hue, Saturation and 

Luminance or Red, Green and Blue values directly into the fields below the color block. When you are satisfied 

with the chosen color, click the “Add to Custom Colors” button to transfer the color to the Custom Color box you 

selected earlier. 

 

Pen Style: Used to set the pen style used when drawing data markers. You can choose from solid, dash, dot, dash-

dot, and dash-dot-dot styles. 

 

Pen Width: Used to set the pen width used when drawing data markers. 

 

Brush Color: Used to set the brush color used to draw data markers. The color is chosen using the same dialogs as 

the Pen Color above. 
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Brush Style: The Brush Style specifies the fill pattern to be applied to the annotation.  The brush choices are: 

 

 

Brush Style Pattern Brush Style Pattern 

 

 
Solid 

 

 
 

 

 
FDiagonal 

 

 
 

 
 

Clear 

 

 
 

 
 

BDiagonal 

 

 
 

 
 

Horizontal 

 

 
 

 
 

Cross 

 

 
 

 
 

Vertical 

 

 
 

 
 

DiagCross 
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Layout 

 

 

Figure B-11 Layout Tab 

 

The Layout tab is a graphical representation of the individual plot components as they are drawn in the plot 
window. You can drag-and-drop individual items to reposition them within the control. You can also change the 
width and height of objects by placing your mouse cursor over one of the ends of the objects (look for the 
cursor to change to a double arrow) and dragging them to the desired size. If you drop one axes object on 
another, and they do not overlap, then the axes will stack on top of one another. To flip the X- and Y- Axes, 
right click anywhere in the Layout tab and select the “XY-Axes Reverse” option to rotate the X- and Y-Axes. The 
Layout tab has the following options: 

 

ToolBar: The ToolBar is the row of buttons at the top of the plot window. This item cannot be moved. 

 

Title: The Title is the title assigned to the plot. 

 

Data View: The Data View is the area where the data is plotted. All objects move in relation to this object, so it 
is fixed. 

 

X-Axis: An individual X-Axis. If you have added multiple X-Axes, there would be multiple X-Axis objects which 
you could reorder or stack. For most applications, however, there will only be a single X-Axis. 

 

Y-Axis: An individual Y-Axis. If you have added multiple Y-Axes, there would be multiple Y-Axis objects which 
you could reorder or stack. For most applications, however, there will only be a single Y-Axis. 

 

Legend: The Legend displays the color legend for the points being plotted in the Data View. 
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Channels 

Channels>General 

 

 

 

Figure B-12 Channels>General Tab 

 

The General sub-tab of the Channel tab is used to set the names, labels, and color used when plotting the 
channel’s data. You can also specify whether the channel is displayed in the plot and/or the legend. You can 
also set whether the x-and y-axes will track as new data in acquired. The General sub-tab has the following 
options: 

Channel List: Located along the left hand side of the window, this is a listing of the channels that have been 
added to the Chart. 

Name: This is the name assigned to the channel. There is no restrictions on the length of the name or the 
characters that can be used. 

Title: The title is the text that is displayed in the legend for this channel. It can be any descriptive title that you 
choose and does not have to be the same as the name. 

Ring Buffer Size: The Ring Buffer Size sets the size of the data buffer, measured in number of data points, 
used for storing channel data. 

Data Style: Use to set the type of dataset that the channel will use. 

X-Axis Name: Specifies the name used when plotting the x-axis data. 

Y-Axis Name: Specifies the name used when plotting the y-axis data. 

Visible: The Visible checkbox determines whether or not the channel selected in the Channel List will be 
displayed on the plot. 

Visible In Legend: The Visible in Legend checkbox specifies whether or not the channel will be listed in the plot 
legend. 

Popup Enabled: The Popup Enabled checkbox enables the plot options for the channel. If Popup Enabled 
is unchecked, you will not be able to right click on the channel name in the index to bring up the options for 
that channel. 

Fast Draw: Enables or disables the Fast Draw feature. This feature dramatically speeds up redraws to the screen 
if you are displaying large data sets (>100000 data points). 

Color: Specifies the pen color used for plotting the channel. Pressing the button will bring up the color window 
shown in Figure B-13. 
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Figure B-13 Color Picker 

Using this window, you can select the color of the line drawn from the Basic Colors or you can define a 
custom color. By clicking the “Define Custom Color>>” button, the color picker shown in Figure B-14 will be 
displayed. 

 

 

Figure B-14 Define Custom Color 

 

First select the Custom Color block you wish to define and then select the desired color by moving the cross-
hairs cursor in the color block. The slider on the right hand side varies from white to the chosen color to 
black to allow you to select the desired shade of your color. Alternately, you can directly enter the Hue, 
Saturation and Luminance or Red, Green and Blue values directly into the fields below the color block. 
When you are satisfied with the chosen color, click the “Add to Custom Colors” button to transfer the color to 
the Custom Color box you selected earlier. 

 

X-Axis Tracking Enabled: The X-Axis Tracking Enabled checkbox specifies whether the x-axis tracks changes 
in the selected channel. 

Y-Axis Tracking Enabled: The Y-Axis Tracking Enabled checkbox specifies whether the y-axis tracks changes 
in the selected channel. 
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Channels>Trace 

 

 

 

Figure B-15 Channels>Trace Tab 

 

The Trace sub-tab of the Channel tab is used to configure the line drawn connecting the channel’s data 
points. In this tab, you can specify the line style as well as its width for each channel as well as determine if that 
channel will be visible or not. The Trace sub-tab has the following options: 

 

Channel List: Located along the left hand side of the window, this is a listing of the channels that have been 
added to the Chart. 

 

Visible:The Visible checkbox determines whether or not the channel selected in the Channel List will be 
displayed on the plot. 

 

Line Style: Used to set the pen style used when plotting the data for the selected channel. You can choose 
from solid, dash, dot, dash-dot, and dash-dot-dot styles. 

 

Line Width: Used to set the pen width used when drawing the channel trace line. 
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Channels>Interpolation 

 

 

Figure B-16 Channels>Interpolation Tab 

 

The Interpolation sub-tab in the Channel tab determines how the line connecting the individual data points will 
be determined. The Interpolation sub-tab has the following option: 

 

Style: The Style option defines which method will be used for interpolating the line connecting the 
channel’s data points. The options are straight line, cubic spline, polynomial, rational, and differential. For most 
applications, the default setting of “straight line” will be the correct choice. 
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Channels>Marker 

 

 

Figure B-17 Channels>Marker Tab 

 

The Marker sub-tab of the Channels tab is used to configure the markers plotted for the channel’s data 
points. You can specify whether or not to use markers for each data point, set the maximum number of 
markers to be drawn and specify the color, size, and style of the markers. The Marker sub-tab has the 
following options: 

 

Show: Specifies whether or not a marker will be drawn at each data point. 

 

Allow Individual: Specifies whether the DataMarkerShow and DataMarkerStyle properties are used to draw 
individual data point data markers.  When this property is set to True, then the data markers are 

 

 

initially drawn using the MarkersStyle property but can be modified individually with the DataMarkerShow and 
DataMarkerStyle properties. When this property is set to False, then all of the data markers are drawn using the 
MarkersStyle property of the channel. 

 

Style: Used to set the pen style used when plotting the data markers for the selected channel. You can choose 
from solid, dash, dot, dash-dot, dash-dot-dot, clear, and inside-frame styles. 

 

Size: Used to set the size of data markers. The Size value is measured in pixels. 

 

Turn off Limit: Sets the maximum number of data markers that will be drawn. 

 

Pen Use Channel Color: Specify whether markers use the channel’s color for the color used to outline the 
markers. If the Pen Use Channel Color button is selected, the marker will be outlined in the channel’s color. 
If the box is unchecked, the pen color will be specified by the Pen Color option below. 
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Pen Color: Specifies the pen color used for plotting the channel. Pressing the button will bring up the color 
window shown in Figure B-18. 

 

 

 

Figure B-18 Color Picker 

 

Using this window, you can select the color of the line drawn from the Basic Colors or you can define a 
custom color. By clicking the “Define Custom Color>>” button, the color picker shown in Figure B-19 will be 
displayed. 

 

 

 

 

 

Figure B-19 Define Custom Color 

 

First select the Custom Color block you wish to define and then select the desired color by moving the cross-
hairs cursor in the color block. The slider on the right hand side varies from white to the chosen color to 
black to allow you to select the desired shade of your color. Alternately, you can directly enter the Hue, 
Saturation and Luminance or Red, Green and Blue values directly into the fields below the color block. 
When you are satisfied with the chosen color, click the “Add to Custom Colors” button to transfer the color to 
the Custom Color box you selected earlier. 
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Pen Width: Used to set the pen width used when drawing data markers. 

 

Brush Use Channel Color: Specifies whether markers use the channel color for the brush color. When the 
Brush Use Channel Color checkbox is checked, the brush uses the color set in the Pen Color property. When the 
Brush Use Channel Color checkbox is unchecked, the brush uses the channel’s color. 

 

Brush Style:The Brush Style specifies the fill pattern to be applied to the marker. The choices are: 

 

 

Brush Style Pattern Brush Style Pattern 

 

 
Solid 

 

 
 

 

 
FDiagonal 

 

 
 

 
 

Clear 

 

 
 

 
 

BDiagonal 

 

 
 

 
 

Horizontal 

 

 
 

 
 

Cross 

 

 
 

 

 

Brush Style Pattern Brush Style Pattern 

 
 

Vertical 

 

 
 

 
 

DiagCross 

 

 
 

 

  



 
 
 

110 © American Auto-Matrix MAN0122US  Rev 5 

M
A

N
0

1
2

2
U

S  R
ev 5

 

Channels>Bar 

 

 

 

Figure B-20 Channels>Bar Tab 

 

The Bar sub-tab of the Channels tab is used to configure the drawing of bars beneath the channel’s data 
points. You can specify the width, color, and pattern to use when drawing the bars. The Bars sub-tab has the 
following options: 

 

Enabled: Use to turn on the bar feature of the channel. When the feature is turned on, a bar with width 
specified using the Width property will be drawn from a y-value specified in the Reference property to the 
channel’s y-value. 

 

Width: Use to specify the width of the bar in units of the x-axis. 

 

Reference: Use to specify the point at which the bar begins to draw in units of the y-axis. 

 

Pen Use Channel Color: Specify whether the bar will use the channel’s color for the color used to outline the 
bar. If the Pen Use Channel Color button is selected, the bar will be outlined in the channel’s color. If the box is 
unchecked, the pen color will be specified by the Pen Color option below. 

Pen Color: Specifies the pen color used for plotting the bar. Pressing the button will bring up the color window 
shown in Figure B-21. 
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Figure B-21 Color Picker 

 

Using this window, you can select the color of the bar drawn from the Basic Colors or you can define a 
custom color. By clicking the “Define Custom Color>>” button, the color picker shown in Figure B-22 will be 
displayed. 

 

Figure B-22 Define Custom Color 

First select the Custom Color block you wish to define and then select the desired color by moving the cross-
hairs cursor in the color block. The slider on the right hand side varies from white to the chosen color to 
black to allow you to select the desired shade of your color. Alternately, you can directly enter the Hue, 
Saturation and Luminance or Red, Green and Blue values directly into the fields below the color block. 
When you are satisfied with the chosen color, click the “Add to Custom Colors” button to transfer the color to 
the Custom Color box you selected earlier. 

Pen Width: Used to set the pen width used when drawing the bar. 

Brush Use Channel Color: Specifies whether bars use the channel color for the brush color. When the Brush 
Use Channel Color checkbox is checked, the brush uses the color set in the Pen Color property. When the 
Brush Use Channel Color checkbox is unchecked, the brush uses the channel’s color. 
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Brush Style:The Brush Style specifies the fill pattern to be applied to the bar. The choices are: 

Brush Style Pattern Brush Style Pattern 

 

 
Solid 

 

 
 

 

 
FDiagonal 

 

 
 

 
 

Clear 

 

 
 

 
 

BDiagonal 

 

 
 

 
 

Horizontal 

 

 
 

 
 

Cross 

 

 
 

 
 

Vertical 

 

 
 

 
 

DiagCross 

 

 
 

 

 

 

Channels>Fill 
 

 

Figure B-23 Channels>Fill Tab 

 

The Fill sub-tab of the Channels is used to create a fill beneath the data line drawn in the plot window. The color 
and pattern used for the fill can be specified as well as the lower bound for the fill pattern. The Fill sub-tab 
has the following options: 

 

Enabled: Specifies to draw a filled bar beneath the channel data points. 
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Use Channel Color: Specifies whether the fill will use the channel color for the brush color. When the Use 
Channel Color checkbox is checked, the fill uses the color set in the Color property. When the Use 
Channel Color checkbox is unchecked, the fill uses the channel’s color. 

 

Reference: Use to specify the point at which the fill begins to draw in units of the y-axis. 

 

Color: Specifies the pen color used for fill.  Pressing the      button will bring up the color window shown in 
Figure B-24. 

 

 

Figure B-24 Color Picker 

 

Using this window, you can select the color of the bar drawn from the Basic Colors or you can define a 
custom color. By clicking the “Define Custom Color>>” button, the color picker shown in Figure B-25 will be 
displayed. 

 

Figure B-25 Define Custom Color 

 

First select the Custom Color block you wish to define and then select the desired color by moving the cross-
hairs cursor in the color block. The slider on the right hand side varies from white to the chosen color to 
black to allow you to select the desired shade of your color. Alternately, you can directly enter the Hue, 
Saturation and Luminance or Red, Green and Blue values directly into the fields below the color block. 
When you are satisfied with the chosen color, click the “Add to Custom Colors” button to transfer the color to 
the Custom Color box you selected earlier. 
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Style: The Style specifies the fill pattern to be applied to the fill. The choices are: 

 

 

Brush Style Pattern Brush Style Pattern 

 

 
Solid 

 

 
 

 

 
FDiagonal 

 

 
 

 
 

Clear 

 

 
 

 
 

BDiagonal 

 

 
 

 
 

Horizontal 

 

 
 

 
 

Cross 

 

 
 

 
 

Vertical 

 

 
 

 
 

DiagCross 

 

 
 

 

 
 

Channels>Digital 

 

 

 

Figure B-26 Channels>Digital Tab 

 

The Digital sub-tab of the Channels tab is used to configure the behavior of channels that are reading 
digital signals. Since a digital signal would be read as either a 1 or a 0 it would be inconvenient to expand the 
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scale to include those values along with other data points. Because of that, the Digital sub-tab allows you to 
scale the value to fit with the rest of your plotted data. You have the option of setting absolute values for 
the on and off states of the output or you can choose to have the values be expressed as a percentage of the 
full scale of the y-axis, keeping the digital channel’s data visible even if you resize the axis.  The Digital sub-tab 
has the following options: 

Enabled: Used to specify whether the data in the channel is interpreted as digital or analog data. If 
Enabled is checked, then values of 0 and 1 are plotted as the Reference Low and Reference High values 
respectively. 

Reference High: Specifies the y-value for digital high values or Logic = TRUE. This is the value used for plotting 
data points while in Digital Mode when the value is not equal to 0. 

Reference Low: Specifies the y-value for digital low values or Logic = FALSE. This is the value used for plotting 
data points while in Digital Mode when the value is equal to 0. 

Reference Style: The Reference Style is used to specify whether the digital data will be plotted as 
absolute values or plotted relative to the full scale of the y-axis. 

If Reference Style is set to “Scale”, then the data will be plotted such that a 0 will be plotted at the value of 
Reference Low and a 1 will be plotted at Reference High. These are absolute values and will adjust if the axis is 
scaled. For example, if the Reference Low and Reference High Values were set to 10 and 50 respectively, 
zooming the axis using the Zoom Out All Axes button would decrease the height of the digital input by half. 

If, Reference Style is set to “Percent”, the values of Reference Low and Reference High will be interpreted as the 
percentage of the y-axis associated with the 0 and 1 states.  These percentages will be used even if the axis is 
resized, meaning the digital data will always have the same height though other, analog inputs can be scaled as 
usual. 
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Channels>File I/O 
 

 

Figure B-27 Channels>File I/O Tab 

 

 

 

Log File Name: Sets the filename (including path) for the log file. Pressing the button allows you to specify 
the location of the log file on your computer. By entering a filename into the “File Name:” field, a new log file 
will be created. 

 

 

Log Buffer Size: Used to set the size of the log buffer, in number of data points. When trending is active, data 
will flow into the log buffer. When the buffer is filled, then data will be written to the log file and the buffer 
cleared. This is useful if you want to regulate how often data is written to the log file. If this value is 0, then data is 
written to the log file after every new data point is added to the chart. 

 

Properties Save/Load: Used to save or load the preferences for the plot. 

 

Data Save/Load: Used to save or load the data points from the plot. 
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Channels>Stats 

 

 

Figure B-28 Channels>Stats Tab 

 

 

The Stats sub-tab in the Channels tab displays a number of useful statistics. These include such things as the 
number of points in the plot, the amount of memory taken up by each data point, the maximum number of 
data points possible, the total memory used to store the points currently plotted, and the minimum, 
maximum, and mean values for both the x- and y-axes. Pressing the Refresh button will update the counts and 
recalculate the values displayed in the Stats tab. 
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Cursors 

Cursors>General 

 

 

 

Figure B-29 Cursors>General Tab 

 

The General sub-tab in the Cursors tab allows you to create cursor objects and define their color and style. The 
General sub-tab has the following options: 

 

Name: Used to set the name of the cursor object. There is no restrictions on the length of the name or the 
characters used. 

 

Style: The Style property determines what type of cursor will be created. You can choose from Value XY, Value X, 
Value Y, Delta X, Delta Y, and Inverse Delta X. The Value X, Value Y, and Value XY options will create a line cursor 
that, when moved through the plot window will display the value(s) associated with the point where the cursor 
crosses the plot. The Delta X and Delta Y options create two lines that can be positioned independently and 
the distance between them will be displayed. The Inverse Delta X operates like the Delta X option except that 
it reports the inverse of the value measured, useful for frequency measurements. 

 

Pointer 1 Position: The Pointer 1 Position can be used to set the initial position of the first cursor. The value 
entered is a percentage of the full scale of the appropriate axis; therefore the only valid values are between 0 
and 100. If the data cursor is horizontal, the position is in reference to the y-axis side of the plot window area 
with 0 being the bottom of the plot and 100 being the top of the plot. If the data cursor is vertical, the 
position is in reference to the x-axis side of the plot area with 0 being the left side of the plot and 100 being 
the right side of the plot. 

 

Pointer 2 Position: The Pointer 1 Position can be used to set the initial position of the second cursor. The value 
entered is a percentage of the full scale of the appropriate axis, therefore the only valid values are between 0 
and 100. If the data cursor is horizontal, the position is in reference to the y-axis side of the plot window area 
with 0 being the bottom of the plot and 100 being the top of the plot. If the data cursor is vertical, the 
position is in reference to the x-axis side of the plot area with 0 being the left side of the plot and 100 being 
the right side of the plot. 
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Use Channel Color: Specify whether the cursors use the channel’s color. If the Use Channel Color button is 
checked, the cursor will be drawn in the channel’s color. If the box is unchecked, the cursor color will be 
specified by the Color option below. 

 

Color: Specifies the color used for drawing the cursor. Pressing the button will bring up the color 

window shown in Figure B-30. 

 

 

 

Figure B-30 Color Picker 

 

Using this window, you can select the color of the line drawn from the Basic Colors or you can define a 
custom color. By clicking the “Define Custom Color>>” button, the color picker shown in Figure B-31 will be 
displayed. 

 

 

 

Figure B-31 Define Custom Color 

 

First select the Custom Color block you wish to define and then select the desired color by moving the cross-
hairs cursor in the color block. The slider on the right hand side varies from white to the chosen color to 
black to allow you to select the desired shade of your color. Alternately, you can directly enter the Hue, 
Saturation and Luminance or Red, Green and Blue values directly into the fields below the color block. 
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When you are satisfied with the chosen color, click the “Add to Custom Colors” button to transfer the color to 
the Custom Color box you selected earlier. 

 

Font: Clicking this button will bring up the dialog shown in Figure B-32. This window can be used to select the 
font family, style, size, and color of the font used for the cursor. Additionally, you can apply the strikeout 
or underline effects to the text. 

 

 

 

 

Figure B-32 Cursor>General>Font Window 

 

 

Popup Enabled: The Popup Enabled checkbox enables the plot options for the cursor. If Popup Enabled is 
unchecked, you will not be able to right click on the cursor to bring up the options for that cursor. 
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Cursors>Hints 

 

 

Figure B-33 Cursors>Hints Tab 

 

The hint is the label drawn with the cursor that displays the plot value. The Hints sub-tab of the Cursor tab 
allows you to configure the behavior of the Hint associated with the selected cursor. The Hints sub-tab has the 
following options: 

 

Show: Specifies whether or not the value display associated with the cursor will be displayed. 

 

Hide On Release: Specifies whether the value display will be automatically hidden when the user releases the 
mouse button. The value will only be shown when the user selects and is moving the cursor. If this property 
is set to True, then the hint will immediately be hidden when the mouse is released. 

 

Position: Use the Position property to set the initial position of the data value next to the chosen cursor. The 
value is specified in percent of the horizontal or vertical range of the plot window. If Position = 25 and the cursor 
is horizontal, then the left-side of the hint will be 25% of the distance from the left side of the plot window. If 
Position = 60 and the cursor is vertical, then the top side of the hint will be 60% of the distance from the top 
side of the plot window 

 

Orientation Side: The Orientation Side property is used to set the initial orientation of the value displayed next 
to the cursor. The orientation will flip automatically if a cursor is moved in such a way as to move the hint 
window outside of the plot window. 
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Limits 

Limits>General 

 

 

Figure B-34 Limits>General Tab 

 

The Limit tab is used to draw guidelines or to shade areas on the plot. You can create guides parallel to the x- 
or y-axes and specify their position and color. Filled areas can also be created to highlight portions of the data 
plot. The Limits tab has the following options: 

 

Name: Used to set the name of the Limit object. There is no restrictions on the length of the name or the 
characters used. 

 

Style: The Style property determines what type of cursor will be created. You can choose from Line X, Line Y, 
Band X, Band Y, Poly Band X, and Poly Band Y.  The Line X and Line Y options will draw a guide line at the 
specified value. The Band X and Band Y will create a shaded vertical or horizontal band, respectively. 

 

Line 1 Position: The Line 1 Position is used to set the position of the limit line or the first line of a band. The 
value entered is a percentage of the full scale of the appropriate axis, therefore the only valid values are 
between 0 and 100. If the data cursor is horizontal, the position is in reference to the y-axis side of the plot 
window area with 0 being the bottom of the plot and 100 being the top of the plot. If the data cursor is vertical, 
the position is in reference to the x-axis side of the plot area with 0 being the left side of the plot and 100 
being the right side of the plot. 

 

Line 2 Position: The Line 2 Position is used to set the position of the second line of a band. The value entered 
is a percentage of the full scale of the appropriate axis, therefore the only valid values are between 0 
and 100. If the data cursor is horizontal, the position is in reference to the y-axis side of the plot window area 
with 0 being the bottom of the plot and 100 being the top of the plot. If the data cursor is vertical, the 
position is in reference to the x-axis side of the plot area with 0 being the left side of the plot and 100 being 
the right side of the plot. 
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Fill Style:The Fill Style specifies the fill pattern to be applied to the limit. The choices are: 

 

Brush Style Pattern Brush Style Pattern 

 

 
Solid 

 

 
 

 

 
FDiagonal 

 

 
 

 
 

Clear 

 

 
 

 
 

BDiagonal 

 

 
 

 
 

Horizontal 

 

 
 

 
 

Cross 

 

 
 

 
 

Vertical 

 

 
 

 
 

DiagCross 

 

 
 

 

Line Style: Used to set the style used when drawing the line(s) for the limit. You can choose from solid, dash, 
dot, dash-dot, and dash-dot-dot styles. Please note, the dotted or dashed pen styles are not available 
when the Width property is not 1 or 0. 

 

Line Width: Used to set the pen width used when drawing the limit line or lines. This property is ignored if the 
Style property is set to Band X, Band Y, Poly BandX, Poly BandY. 

 

Color: Specifies the color used for drawing the Limit line or area. Pressing the button will bring up the color 
window shown in Figure B-35. 

 

Figure B-35 Color Picker 



 
 
 

124 © American Auto-Matrix MAN0122US  Rev 5 

M
A

N
0

1
2

2
U

S  R
ev 5

 

 

 

Using this window, you can select the color of the line drawn from the Basic Colors or you can define a 
custom color. By clicking the “Define Custom Color>>” button, the color picker shown in Figure B-36 will be 
displayed. 

 

 

 

Figure B-36 Define Custom Color 

 

First select the Custom Color block you wish to define and then select the desired color by moving the cross-
hairs cursor in the color block. The slider on the right hand side varies from white to the chosen color to 
black to allow you to select the desired shade of your color. Alternately, you can directly enter the Hue, 
Saturation and Luminance or Red, Green and Blue values directly into the fields below the color block. 
When you are satisfied with the chosen color, click the “Add to Custom Colors” button to transfer the color to 
the Custom Color box you selected earlier. 

 

X-Axis Name: If the plot is configured to have multiple x-axes, the X-Axis Name is used to select which axis 
the values to which the entered values for Line 1 Position and Line 2 Position refer. 

 

Y-Axis Name: If the plot is configured to have multiple y-axes, the Y-Axis Name is used to select which axis 
the values to which the entered values for Line 1 Position and Line 2 Position refer. 
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Labels 

Labels>General 

 

 

 

Figure B-37 Labels>General Tab 

 

Name: The Name property is used to assign a name to the Label object. There is no restrictions on the length 
of the name or the characters used. 

Visible:The Visible property is used to specify whether or not the label is visible in the plot window. 

Font: Clicking this button will bring up the dialog shown in Figure B-38. This window can be used to select the 
font family, style, size, and color of the font used for the label. Additionally, you can apply the strikeout or 
underline effects to the text. 

 

Figure B-38 Labels>General>Font Window 

Caption: The Caption property contains the text that is displayed in the plot window when the Visible 
property is checked. 

Alignment: The Alignment property specifies how the caption text will be aligned when it is drawn. 

Margin: Use Margin to get or set the margin between the Caption and the top, bottom, left, and right of the 
Label Object. The Margin values is in percent of the title font height or width. 
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X- and Y-Axes 

X- And Y-Axes>General 

 

 

 

Figure B-39 X- and Y-Axes>General Tab 

 

The General sub-tab in the X- and Y-Axes tabs is used to specify the parameters of the axes such as the limits of 
the scale on the axis, whether the scale is normal or logarithmic, and whether the scale is normal or reverse 
reading. The General sub tab has the following options: 

 

 

Name: The Name property is the name assigned to the x- or y-axis object. You can configure the plot to have 
multiple axes 

 

Min: Used to set the minimum value that will be displayed on the axis. 

 

Span: Used to set the range displayed on the axis. The maximum value displayed will be equal to the Min plus 
the Span. 

 

Desired Start: The Desired Start property specifies the desired value for the first major tick on the axes. For 
example, when your axis ranges from 0 to 100, as it does in the default plot window, major ticks occur in 
increments of 10 starting at 0. However, if you set the Desired start to 6, the major ticks would occur at 6, 16, 
26, 36, etc. Setting Desired Start to 0 returns the plot to its normal method of determining the placement 
of ticks. 

 

Desired Increment: The Desired Increment property allows you to manually specify the spacing between major 
ticks. In the default window, the axis ranges from 0 to 100 with a major tick in increments of 10. If you wished 
to only display major ticks at 0, 25, 50, and 100, you could set the Desired increment to 25. 

 

Scale Type: The Scale Type specifies whether the chosen axis is a normal or a logarithmic axis. 
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Visible: The Visible property is used to specify whether or not the axis is visible in the plot window. 

 

Grid Lines Visible: The Grid Lines Visible property is used to specify whether or not the grid lines will be drawn. 

 

 

Enabled: The Enabled property is used to enable or disable the interface to the axis. If the Enabled 
Property is unchecked, the axis will be locked and will not be able to be scrolled or zoomed. When the 
Enabled property is checked, the axis behaves as normal. 

 

Popup Enabled: The Popup Enabled checkbox enables the plot options for the channel. If Popup Enabled 
is unchecked, you will not be able to right click on the axis to bring up the options for that axis. 

 

Reverse Scale: The Reverse Scale option is used to reverse the direction that the scale on the axis 
increases. If Reverse Scale is checked the axis will proceed from right to left rather that the normal left to right 
progression. 

 

Restore Values On Resume: Use Restore Values On Resume to set whether or not the axis restores the original 
axis parameters and values that were in effect when the Pause All Tracking Button is clicked. All parameters 
(such as axis min and span) are restored when the Resume All Tracking Button is clicked and this property is set 
to TRUE. 

 

Master UI Input: The Master UI Input property allows you to configure multiple axes to all take the same 
input. What this means is that if you scroll one axis then all of the axes with the Master UI Input selected will 
be scaled by the same amount. 
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X- And Y-Axes>Title 
 

 

Figure B-40 X- and Y-Axes>Title Tab 

 

The Title sub-tab in the X- and Y-Axes tabs is used to specify a title for the axis. The Title tab has the 
following options: 

 

Show: Specifies whether or not the axis title is shown. 

 

Text: Specifies the text that will be displayed if the Show property is checked. 

 

Margin: Sets the margin between the  axis title  and axis scale labels.  The Margin represents  the 
percentage of a character size and is based on the font used for the axis. A value of 0.5 is equal to half the size of 
a character. 

 

Font: Clicking this button will bring up the dialog shown in Figure B-41. This window can be used to select the 
font family, style, size, and color of the font used for the axis title. Additionally, you can apply the strikeout 
or underline effects to the text. 

 

 

Figure B-41 X- and Y-Axes>Title>Font 
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X- And Y-Axes>Labels 

 

 

 

Figure B-42 X- and Y-Axes>Labels Tab 

 

The Labels sub-tab of the X- and X-Axis tabs is used to configure how the axis labels for will be displayed. You can 
specify the precision, display style, font, and spacings for the label text. The Labels sub-tab has the following 
options: 

 

Visible: Specifies whether or not the axis labels are displayed. 

 

Font: Clicking this button will bring up the dialog shown in Figure B-43. This window can be used to select the 
font family, style, size, and color of the font used for the axis labels. Additionally, you can apply the strikeout 
or underline effects to the text. 

 

 

Figure B-43 X- and Y-Axes>Labels>Font 

 

Min Length: Used to set the minimum label length used in calculating the number of scale labels. The Trend 
Viewer’s automatic scaling calculates the number of scale labels based on the Font, Separation, and Min 
Length to ensure labels that are readable. 
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Margin: The Margin property is used to set the spacing between the major tick and major tick labels. The 
Margin is represented the percentage of a character size and is based on the Font used for the axis. A value 
of 0.5 is equal to half the size of a character. 

 

Label Separation: The Label Separation property is used to set the minimum separation between scale labels. 
Label Separation represents the percentage of a character size and is based on the Font used for the axis. A 
value of 0.5 is equal to half the size of a character. The actual separation maybe greater due to the Trend Viewer 
automatically reducing the number of major ticks to keep the scale readable. 

 

Precision: The Precision property is used to set the precision of the axis labels. The precision will 
represent either the number of significant digits or the number of decimal places, depending on the setting of 
the Precision Style property. 

 

Precision Style: The Precision Style property specifies how the Precision property is interpreted when 
formatting scale labels. When Precision Style is set to Significant Digits, the number of digits to the right of the 
decimal point is automatically calculated to ensure that the span of the values will show enough 
significant digits. When the Precision Style is set to Fixed Decimal Points, then the labels will be displayed with a 
number of decimal places equal to the value of the Precision property. 

 

Format Style: The Format Style property sets the formatting style of scale labels. You can choose from value, 
exponent, prefix, date/time, and pricing 32nds. The Value option simply uses the raw value as the tick label. 
The exponent setting uses scientific notation of the form X.XXe+NNN. A value of 1500 with this setting would be 
written as 1.50e+002. The prefix setting will express the axis ticks using a shorthand of adding a K for values 
over 1000 and M for millions. With this setting, 1500, for example, would be written as 1.5K. The date/time 
setting tells the Trend Viewer to display the axis ticks as date information. 

 

Min Length Auto Adjust: The Min Length Auto Adjust property specifies whether the Min Length property is 
automatically adjusted as the minimum required label length increases. 

While the Trend Viewer is plotting, or the user is scrolling or zooming the plot, the actual minimum label 
length may become greater than the Min Length value. This will result it the axis growing to accommodate the 
wider label. If the displayed data changes so as to cause the label width to vary, it may cause an annoying 
oscillation of the display plot objects sizes. To prevent this oscillation, check this property. The Min Length 
property is stored when the Tracking Enabled property is set to False. The Min Length property will be restored 
to the previous value when Tracking Enabled property is set back to True. 
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X- And Y-Axes>Tracking 

 

 

 

Figure B-44 X- and Y-Axes>Tracking Tab 

 

The Tracking sub-tab of the X- and Y-Axis tabs is used to configure the behavior of the plot when data has been 
collected that cannot currently fit in the plot window. Using the properties in the Tracking sub-tab, you can 
configure how the plot will be adjusted to account for the additional data. The Tracking sub-tab has the 
following options: 

 

Enabled: Specifies whether or not the axis will automatically adjust itself as new data points are read from the 
channel. Depending on the Style, When the Tracking is enabled, the axis will scroll or compress based on the new 
tracking data. 

 

Style: The Tracking Style specifies how the axis adjusts itself in response to new tracking data if off scale. The 
Style options are Scale Min & Max, Scale Max, Scale Min, Scroll Smooth, Scroll Page, and Expand Collapse. The 
Scale Min, Scale Max, and Scale Min & max will adjust the axes if the data goes below the minimum, above the 
maximum, or both. When this occurs, the scale will be adjusted to include the new data point. The Scroll 
Smooth option will simply shift the area of the plot for each new data point added. Once the data fills the plot 
window, as each new data point is read, the oldest point will be scrolled off the screen. The Scroll Page option 
works in a similar fashion, except that instead of scrolling a single point, it will shift the plot entirely such that 
the new data point starts at the left hand side of the plot window. 

 

Align First Style: The Align First Style property is used to specify how the axis aligns itself when it 
receives its first data points from the channel(s) being plotted. If there is more than one channel sending 
tracking data, only the data from the first channel is used to determine the first alignment. 

 

Scroll Compress Max: The Scroll Compress Max property is used to set the maximum span value when 
compressing the scale. When new data is read in from the channel being plotted and Tracking has been 
enabled, the Span property will be Compressed to include the data if the current Span property is less than 
the value of the Scroll Compress Max property. To disable this feature, set Scroll Compress Max to 0. 
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X- And Y-Axes>Cursor 

 

 

Figure B-45 X- and Y-Axes>Cursor Tab 

 

The Cursor sub-tab of the X- and Y-Axis tabs are used to configure the behavior of cursors associated with the 
axis. The number of significant digits as well as a scaling factor for frequency calculations are entered in this 
sub-tab. The Cursor sub-tab has the following options: 

 

Precision: The Precision property specifies the number of significant digits to be displayed by Cursor object 
that measure values on the chosen axis. For example, a Precision of 3 would give a reading of 11.8 whereas a 
Precision of 5 would give a value of 11.757. 

 

Cursor Scalar: The Cursor Scaler property is used with cursors that have their Style property set to 
InverseDeltaX, typically used for frequency calculations. The Cursor Scalar is a multiplier used to convert this 
axis’ units to seconds format so that the cursor can property display the frequency calculation. 
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X- And Y-Axes>Scroll 

 

 

 

Figure B-46 X- and Y-Axes>Scroll Tab 

 

The Scroll sub-tab of the X- and Y-Axis tabs is used to set limits on the user’s ability to scroll the plot. The Scroll 
sub-tab has the following options: 

 

 

Min/Max Enabled: Use Min/Max Enabled to specify a fixed range for the scrolling of the selected axis. If 
Min/Max Enabled is checked, then the axis will stop scrolling when Max and/or Min are reached on the 
scale. 

 

Min:Specifies a fixed maximum limit on scrolling of the axis. If the user attempts to scroll the axis past this point 
on the axis and Min/Max Enabled is checked, the axis will not scroll past the specified maximum point. 

 

Max: Specifies a fixed maximum limit on scrolling of the axis. If the user attempts to scroll the axis past this point 
on the axis and Min/Max Enabled is checked, the axis will not scroll past the specified maximum point. 
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X- And Y-Axes>Scale 

 

 

 

Figure B-47 X- and Y-Axes>Scale Tab 

 

The Scale sub-tab of the X- and Y-Axis tabs is used to set a number of parameters dealing with how the scales 
for the chosen axis will be displayed. The Scale sub-tab has the following options: 

 

Major Length:The Major Length property is used to set the length of the major ticks for the axis. This value 
is measured in pixels. 

 

Minor Length: The Minor Length property is used to set the length of the minor ticks for the axis. This value 
is measured in pixels. 

 

Minor Count: The Minor Count property sets the number of minor divisions between each major division. 
Minor Count should be set to one less than the desired number of minor sections. For example, if you want 5 
minor sections, set Minor Count to 4 since 4 divisions would result in 5 sections. 

 

Scale Lines Color: Specifies the color used for drawing the tick marks for the axis.  Pressing the button will 
bring up the color window shown in Figure B-48. 

 

 

Figure B-48 Color Picker 
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Using this window, you can select the color of the line and tick marks drawn from the Basic Colors or you can 
define a custom color. By clicking the “Define Custom Color>>” button, the color picker shown in Figure B-
49 will be displayed. 

 

 

Figure B-49 Define Custom Color 

 

First select the Custom Color block you wish to define and then select the desired color by moving the cross-
hairs cursor in the color block. The slider on the right hand side varies from white to the chosen color to 
black to allow you to select the desired shade of your color. Alternately, you can directly enter the Hue, 
Saturation and Luminance or Red, Green and Blue values directly into the fields below the color block. 
When you are satisfied with the chosen color, click the “Add to Custom Colors” button to transfer the color to 
the Custom Color box you selected earlier. 

 

Inner Margin: Sets the margin between the axis line and the data plot window. The Inner Margin value is 
measured in pixels. 

 

Outer Margin: Sets the margin between the axis line and the axis label. The Outer Margin value is 
measured in pixels. 

 

 

Stacking Ends Margin: The Stacking Ends Margin property sets the margin at the end of the axis when stacked. 
Stacking Ends Margin is measured as a percentage of a character size and is based on the Font used for the axis. 
A value of 0.5 would, therefore, be equal to half the size of a character. 

 

Start Percent: The Start Percent property specifies where, relative to the axis, to begin drawing the scale. For 
example, a Start Percent of 20 will cause the scale to start one fifth of the way along the axis. 

 

Stop Percent: The Stop Percent property specifies where, relative to the axis, to end drawing the scale. For 
example, a Stop Percent of 75 will cause the scale to end one quarter of the way from the end of the axis. 
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X- And Y-Axes>Cartesian 

 

 

 

Figure B-50 X- and Y-Axes>Cartesian Tab 

 

 

Style: Use MajorLength to get or set the axis major ticks length. 

 

Child Ref Axis Name: Use CartesianChildRefAxisName to get or set the name of the Axis used for 
referencing the axis. The specified Axis Name refers to the perpendicular axis scale that will be used to 
position this Child Cartesian Axis when using the CartesianChildRefValue property. This property only affects 
Axes that have their CartesianStyle set to ipcsChild. 

 

Child Ref Value: Use CartesianChildRefValue to get or set the position of a Child Cartesian Axis along its 
perpendicular reference axis specified by the CartesianChildRefAxisName property. This property only 
affects Axes that have their CartesianStyle set to ipcsChild. 
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Legend 

 

 

 

 

 

 

 

 

 

Figure B-51 Legend Tab 

 

The Legend tab is used to configure the display of the plot legend. Using the properties in this tab, you can 
specify the fonts, color, and spacings used when displaying the legend. The Legend tab has the following 
options: 

 

Visible: Use the Visible property to show or hide the plot legend. 

 

Enabled: The Enabled property is used to enable or disable the plot legend. If the Enabled property is 
unchecked, the legend will not be displayed in the plot window. When the Enabled property is checked, the 
legend will be shown in the position specified in the Layout tab. 

 

Popup Enabled: The Popup Enabled checkbox enables the popup menu for the plot legend. If Popup Enabled 
is unchecked, you will not be able to right click on the channel name in the index to bring up the options for 
the plot legend. 

 

Channel Name Max Width: Use Channel Name Max Width to specify the maximum channel name width 
allowed in the Legend before word wrapping occurs. This property allows you to set a maximum width of the 
Channel Name column, allowing those channel names that exceed this width to word-wrap to the next line. 

 

Column Spacing Specifies the spacing between columns in the legend. Column Spacing is measured as a 
percentage of a character size and is based on the Font used in the Legend. A value of 0.5 is equal to half the 
width of a character. 

 

Row Spacing: Specifies the spacing between rows in the legend. Column Spacing is measured as a 
percentage of a character size and is based on the Font used in the Legend. A value of 0.5 is equal to half the 
width of a character. 
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Column Font: Clicking this button will bring up the dialog shown in Figure B-52. This window can be used to 
select the font family, style, size, and color of the font used for the legend entries. Additionally, you can apply 
the strikeout or underline effects to the text. 

 

Figure B-52 Legend>Font 

 

 

Margin: The Margin option is used to set the margin around the left, right, top, and bottom edge of the 
legend. The values are measured as multiples of a character size and is based on the Font used in the 
Legend. 

 

Background Transparent: The Background Transparent property is used to specify whether the background 
behind the legend shows through or if the legend will have its own background color. 

 

Background Color: The Background Color property sets the background color of the legend to be used if 

the Background Transparent option is unchecked. Pressing the button will bring up the color window shown in 
Figure B-53. 

 

 

Figure B-53 Color Picker 
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Using this window, you can select the color of the line and tick marks drawn from the Basic Colors or you can 
define a custom color. By clicking the “Define Custom Color>>” button, the color picker shown in Figure B-
54 will be displayed. 

 

 

Figure B-54 Define Custom Color 

 

First select the Custom Color block you wish to define and then select the desired color by moving the cross-
hairs cursor in the color block. The slider on the right hand side varies from white to the chosen color to 
black to allow you to select the desired shade of your color. Alternately, you can directly enter the Hue, 
Saturation and Luminance or Red, Green and Blue values directly into the fields below the color block. 
When you are satisfied with the chosen color, click the “Add to Custom Colors” button to transfer the color to 
the Custom Color box you selected earlier. 

 

Selected Item Background Color: The Selected Item Background Color property is used to set the 
background color of the selected items in the legend. The color is selected in the same manner as the 
Background Color. 

 

Selected Item Font: The font to be used when an item in the legend is selected. The font is selected in the 
same manner as the Column Font. 

 

Titles Visible: The Titles Visible property specifies whether or not the column titles are visible in the 
legend. 

 

Titles Font: The Titles Font is the font which will be used when drawing the column titles in the legend. The 
font is selected in the same manner as the Column Font and the Selected Item Font. 

 

Show Column Line: The Show Column Line property specifies whether or not the column for the line 
segment showing the channel’s color is displayed in the legend. 

 

Show Column Marker: The Show Column Marker property specifies whether or not the column for the 
channel’s marker symbol is displayed in the legend. 
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Show Column X-Axis Title: The Show Column X-Axis Title property specifies whether or not the column for the 
x-axis title associated with the channel is displayed in the legend. 

 

Show Column Y-Axis Title: The Show Column Y-Axis Title property specifies whether or not the column for the 
y-axis title associated with the channel is displayed in the legend. 

 

Show Column X-Value: The Show Column X-Value property specifies whether or not the column for the value 
of the most recently added x-value is displayed in the legend. 

 

 

Show Column Y-Value: The Show Column Y-Value property specifies whether or not the column for the value 
of the most recently added y-value is displayed in the legend. 

 

Show Column Y-Max: The Show Column Y-Max property specifies whether or not the column for the value 
of the maximum y-value is displayed in the legend. 

 

Show Column Y-Min: The Show Column Y-Min property specifies whether or not the column for the value of the 
minimum y-value is displayed in the legend. 

 

Show Column Y-Mean: The Show Column Y-Mean property specifies whether or not the column for the value 
of the mean y-value is displayed in the legend. 
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Toolbar 

 

 

Figure B-55 Toolbar Tab 

 

The Toolbar tab is used to configure the display of the components on the toolbar in the plot window. 
Using the options in this tab, you can specify which button you want on the toolbar or if you want the 
toolbar to be visible at all. You can also specify the zoom factor associated with the Zoom In and Zoom Out 
buttons. 

 

Visible: Shows or hides entire tool bar in the plot window. 

 

Enabled: The Enabled checkbox enables the plot options for the toolbar. If Enabled is unchecked, you will not be 
able to right click on the toolbar to bring up the options for the plot legend. 

 

Popup Enabled: Use the Popup Enabled property to enable or disable the Popup Menu of a Plot Object. The 
Popup Menu is shown when a user right-clicks on this Plot Object. Setting this property to FALSE is useful if you 
don’t want the Popup Menu functionality of this Plot Object in your particular application. 

 

Zoom In/Out Factor: The Zoom In/Out Factor property determines how much the axes will be zoomed in or out 
when the Zoom In All Axes or Zoom Out All Axes buttons are pressed. The zoom factor is expressed in 
relation to the original scale, so a zoom factor of 2 would increase or decrease the axes by a factor of two. For 
axes with logarithmic scales, this property has no effect. Log based scales will always zoom by a factor of 2 
regardless of this property’s value. 

 

Show Button: Determines whether a specific button is shown on the tool bar or not. Placing a check in the 
box next to a button’s name will cause the button to be visible in the toolbar. 

 

NOTE 

The Resume, Pause, and Select buttons are, by default, not

visible in the toolbar as they do not do anything. Enabling

them in the Trend Viewer will make the buttons visible, but

they will have no function. 
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Data View 

Data View>General 

 

 

 

 

Figure B-56 Data View>General Tab 

 

The General sub-tab of the Data View tab is used to specify the background color for the plot window as well 
as whether gridlines will be drawn and the axes to which they are connected. The General sub-tab has the 
following options: 

 

Enabled: The Enabled property is used to enable or disable the plot legend. If the Enabled property is 
unchecked, the legend will not be displayed in the plot window. When the Enabled property is checked, the 
legend will be show in the position specified in the Layout tab. 

Popup Enabled: The Popup Enabled checkbox enables the popup menu for the plot legend. If Popup Enabled 
is unchecked, you will not be able to right click on the channel name in the index to bring up the options for 
the plot legend. 

Background Transparent: Use Background Transparent to specify whether the background behind the data 
view shows through. 

Background Color: Use Background Color property to set the background color of the data view. 

Pressing the   button will bring up the color window shown in Figure B-57. 
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Figure B-57 Color Picker 

 

Using this window, you can select the color of the background from the Basic Colors or you can define a 
custom color. By clicking the “Define Custom Color>>” button, the color picker shown in Figure B-58 will be 
displayed. 

 

 

 

Figure B-58 Define Custom Color 

 

First select the Custom Color block you wish to define and then select the desired color by moving the cross-
hairs cursor in the color block. The slider on the right hand side varies from white to the chosen color to 
black to allow you to select the desired shade of your color. Alternately, you can directly enter the Hue, 
Saturation and Luminance or Red, Green and Blue values directly into the fields below the color block. 
When you are satisfied with the chosen color, click the “Add to Custom Colors” button to transfer the color to 
the Custom Color box you selected earlier. 

 

Grid Show: Unchecking the Grid Show checkbox will hide the gridlines drawn on the plot. 

 

Grid X-Axis Name: If you are configuring a plot with multiple x-axes, the Grid X-Axis Name property 
specifies which axis will be used to determine the grid lines that will be drawn in the plot. 

 

Grid Y-Axis Name: If you are configuring a plot with multiple y-axes, the Grid Y-Axis Name property 
specifies which axis will be used to determine the grid lines that will be drawn in the plot. 
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Dataview>Grid Lines 

 

 

 

Figure B-59 Data View>Grid Lines Tab 

The Grid Lines sub-tab in the Data View tab is used to configure the display of the grid lines associated with 
the major and minor divisions along the axes. The Grid Lines sub-tab has the following options: 

Color: Use to specify the overall/default color of the grid lines. You can override specific X-Axis and Y-Axis major 
and minor tick line settings using properties in the X-Majors, X-Minors, Y-Majors, and Y-Minors sub-tabs. 
Pressing the       button will bring up the color window shown in Figure B-60. 

 

Figure B-60 Color Picker 

Using this window, you can select the color of the grid lines from the Basic Colors or you can define a 
custom color. By clicking the “Define Custom Color>>” button, the color picker shown in Figure B-61 will be 
displayed. 
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Figure B-61 Define Custom Color 

 

First select the Custom Color block you wish to define and then select the desired color by moving the cross-
hairs cursor in the color block. The slider on the right hand side varies from white to the chosen color to 
black to allow you to select the desired shade of your color. Alternately, you can directly enter the Hue, 
Saturation and Luminance or Red, Green and Blue values directly into the fields below the color block. 
When you are satisfied with the chosen color, click the “Add to Custom Colors” button to transfer the color to 
the Custom Color box you selected earlier. 

 

Show Left/Right/Top/Bottom: Specifies whether the left, right, top, and bottom borders will be drawn on the 
plot. 

 

Major Style: The Major Style property is used to set the line style for the major grid lines. You can choose from 
solid, dash, dot, or small dot styles. You can override specific X-Axis and Y-Axis major tick line settings 
using properties in the X-Majors and Y-Majors sub-tabs. 

 

Minor Style: The Minor Style property is used to set the line style for the minor grid lines. You can choose from 
solid, dash, dot, or small dot styles. You can override specific X-Axis and Y-Axis minor tick line settings 
using properties in the X-Minors and Y-Minors sub-tabs. 

 

X-Major, X-Minor, Y-Major, Y-Minor Sub-Tabs 
 

The X-Major, X-Minor, Y-Major, and Y-Minor sub-tabs are used to override the drawing options for specific 
major or minor divisions of a single axis. 

 

Show: Use to specify whether grid lines for this specific axis tick type are shown. 

 

Custom: Use to specify whether the options in the Custom Properties box override the grid settings 
specified previously for this Axis tick type. 

 

Custom Properties - Color: Use to specify the grid line color for this Axis tick type. The color is selected in the 
same manner as for the Grid Line Color property. 
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Custom Properties - Width: Use to specify the grid line width, in pixels, for this Axis tick type. 

 

Custom Properties - Style: Use to specify the grid line style for this Axis tick type. You can choose from solid, 
dash, dot, or small dot styles. 
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DEVICE NUMBERING 

The way in which you assign unit ID numbers to the controllers on your MSTP network can have an effect on 
the overall communications performance. To understand why this is the case, you need to understand MSTP 
token passing and what happens when a token is dropped. 

 

In a normally functioning MSTP network, the token is passed to each controller sequentially by unit ID 
number. After a device passes the token to the next device on the network, it waits to see if the recipient is using 
the token. If a specified timeout is exceed, 300 mS for BACnet, then a Poll for Master request will be generated. 
When this request is made the devices are sequentially interrogated, starting with the next ID number until a 
master device is found which can receive a new token. If your devices are numbered such that the devices 
which will respond to the Poll for Master request are numbered lower, it will take less time for a master device 
to be found and a new token generated. This translates to improved performance of your BACnet network. 

 

Ideally, devices should be numbered sequentially, starting with zero. If an NB-Link device is being used, it 

should be numbered 0. If no NB-Link is being used, any area controllers, such as a SAGE, should have the 

lowest numbers. With an NB-Link, any SAGEs or other area controllers would be numbered starting with 1. 
In either case, these devices should be followed by any controllers which have programs which access the 
network. Finally, any other controllers would be included last in the numbering. 

 

MAX_INFO_FRAMES 

The value of Max_Info_Frames specifies the maximum number of information frames the node may send 
before it must pass the token. Max_Info_Frames may have different values on different nodes. This may be 
used to allocate more or less of the available link bandwidth to particular nodes. 

 

MAX_MASTER 

The max_master property represents the highest identifier number that can be a master device on the 
network. This number is the highest identifier number to which the token will be passed. Network 
performance will be slowed if the controllers are polling for master to identifier numbers which do not have 
devices associated with them. To prevent this, the max_master should be set to a value one higher than the 
highest numbered master device on your network. This will improve network performance by reducing the time 
needed to poll for master to devices on the network. 

 

 



 
 

 

SECTION 7 :  APPENDIX D:
 TROUBLESHOOTING COMMON 
PROBLEMS 

 

 

 

 

 

  



 
 
 

150 © American Auto-Matrix MAN0122US  Rev 5 

M
A

N
0

1
2

2
U

S  R
ev 5

 

 

PROBLEM: NB-Pro cannot connect to the NB-Link. 

SOLUTION: 
 Test and determine if your PC can 'see' the NB-Link, try a PING test. To perform a ping test, go to the 

Windows START button and select the RUN option. Type the word COMMAND at the Open dialog box 

and hit OK.  This will bring you to a DOS Prompt.  Type “ping <IP address of NB-Link>” substituting the 
address for your link. If the unit is live on the network, you should receive replies back from the IP 

address that NB-Link is assigned to. If you do not, it is recommended that you check the power 

source where the NB-Link's adapter is plugged into, as well as all network cabling between your PC 

and the NB-Link. 

 Verify network-addressing information of your PC's network interface card. If you are unsure of the 
address configuration, consult a network administrator for more help. 

PROBLEM: When I start NB-Pro, I can see the IP address of my NB-Link in the Device Panel. 
However, I cannot see any MS/TP devices. 

SOLUTION: 
 

 Check the baud rate at which your NB-Link is set to communicate at. 

 

 Verify that the DB25 device is wired properly (N+ to TX+ and N- to RX-) 

 

 Verify that your MAC Address (TS) is set to a unique number that is not assigned to any other MS/TP 
Device on the network. Note that Native Series devices default ID numbers to the last two digits of the 
unit's serial number. 

PROBLEM: NB-Pro cannot seem to find some devices on the MS/TP network. 

SOLUTION: 
 

 Check to make sure all devices have unique ID numbers. If two devices have the same ID number, 
network communications is likely to degrade. 

 Verify all network wiring along the MS/TP network. Make sure all controllers are connected in a daisy 

chain format. NB-Pro/NB-Link supports up to 32 MS/TP controllers without the use of a repeater. With 
the use of an EIA-485 repeater, you may communicate with up to 64 devices. Pay close attention to 
the distance of wire runs in your network. All wiring must conform to the RS-485 wiring standards. In 

addition, it is recommended that NB-Pro/NB-Link connect electrically at the end of the network. 'T-
tapping' can result in network communication errors. 

 Users can send a Who-Is to devices on the network from the Utilities menu to find additional devices 
that may have been added to the network. 

 Verify that all devices on the MS/TP network are set to master mode. If a device is set to slave, you 
must add the device manually. 

 Confirm that all deices are configured to operate at the same baud rate. 
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PROBLEM: I changed my controller's ID number and now I can no longer communicate to the 
device. 

SOLUTION: 
 When you change a unit ID number on a Native Series device, the change takes effect immediately. 

This causes the controller to be non-responsive when attempting to communicate with it. Users 
should access the Discovery menu and select Locate Devices to find the controller. 

PROBLEM:  NB-Pro will only discover devices up to a certain unit number.  If I try to add the 
device manually or perform a 'Send Who Is', the controller cannot be discovered. 

SOLUTION: 
 

 The Max Master value in the NB-Link and/or your controllers is set to a number lower than the unit ID 
number of the device you are trying to discover. It is recommended that you assign all unit ID 
numbers to controllers on the MSTP network and then set Max Master to be just higher than the 
last assigned unit ID. 

 

PROBLEM:  When I attempt to open my capture file offline, I receive a message from Windows 
stating that I need to select a program to open it with. What program can I use to edit capture 
files? 

SOLUTION: 
 

 Any standard text editor program can open the .cap file format that NB-Pro generated when saving a 
capture file. 
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10BASET, 10BASE2, 10BASEF,100BASET 

See Ethernet. 

American National Standards Institute (ANSI) 

Founded in 1918, ANSI is administrator and coordinator of the United States private sector voluntary 
standardization system. ANSI facilitates development of American National Standards, such as BACnet, by 
establishing consensus among qualified groups. The Institute ensures that its guiding principles-consensus, due 
process and openness-are followed by the more than 175 distinct entities that it accredits (organizations, 
committees, and canvasses). 

 

American Society of Heating, Refrigerating and Air-Conditioning Engineers (ASHRAE) 

An organization with chapters throughout the world, ASHRAE advances the arts and sciences of heating, 
ventilation, air conditioning, and refrigeration for the public's benefit through research, standards writing, 
continuing education, and publications. Through its membership, ASHRAE writes standards that set uniform 
methods of testing and rating equipment and establish accepted practices for the industry worldwide. 

 

ARCNET 

Short for Attached Resources Computer NETwork (ANSI/ATA 878.1). ARCNET is one of the oldest, simplest, and 
least expensive types of local area network (LAN). Datapoint Corporation introduced ARCNET in 1968. It uses a 
token-ring architecture, supports data rates up to 2.5 Mbps, connects up to 255 devices, and runs on a variety of 
media, including twisted-pair, coaxial cable, and fiber-optic cable. 

 

BACnet® 

Short for the Building Automation and Control networking protocol (ANSI/ASHRAE Standard 135-1995). 
BACnet is a non-proprietary communication protocol standard conceived by a consortium of building managers, 
system users, and manufacturers under the auspices of ASHRAE. 

 

BACnet Interest Group (BIG) 

Associations formed by BACnet users for the benefit of BACnet users. BIGs enable individuals to exchange 
information and share experiences about the implementation and application of BACnet. Many BACnet 
Interest Groups have formed around the world to support BACnet users. There is BIG-NA, North America 
(www.big-na.org); BIG-EU, Europe (www.big-eu.org), and BIG-AA, AustralAsia (www.big-aa.org). 

 

BACnet Interoperability Building Blocks (BIBBS) 
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Collections of one or more BACnet services that function to define the interoperational capabilities of a 
BACnet device. Certain BIBBs may also be predicated on the support of certain, otherwise optional, BACnet 
objects or properties. BIBBs may also constrain allowable values of specific properties or service parameters. 

BACnet Manufacturers Association™ (BMA) 

An organization of companies that design, market, and install BACnet-based building automation products. 

BACnet Testing Laboratories™ (BTL) 

The BACnet Manufacturers Association formed the BACnet Testing Laboratories to test building automation 
products and certify them as BACnet compliant. 

Bridge 

A device that connects two LANs or two segments of the same LAN. The LANs can be alike or different. A bridge 
can connect an Ethernet and token-ring network, for example. Unlike routers, bridges are protocol independent. 
They forward messages without analyzing or rerouting them. 

Client/Server  

Occasionally called a two-tier architecture. Clients rely on servers for resources, such as files, devices, and 
processing power. Servers are usually more powerful computers or processors. 

Coaxial Cable 

A round, flexible, two-conductor cable that consists of a copper wire (at the center), a layer of protective 
insulation, a braided mesh sleeve, and an outer shield, or jacket. Coaxial cable is used in 10Base2 Ethernet 
applications and in some ARCNET applications. 

Conformance Class 

Like BIBBs, conformance classes provide a method of describing various capabilities of a device for 
communicating data and interoperating with other BACnet devices. A device's protocol implementation 
conformance statement (PICS) details its conformance class. 

Device, BACnet 

Any equipment that supports digital communication using the BACnet protocol. 

Ethernet 

The IEEE 802.3 standard for contention networks. Ethernet is one of the most widely implemented LAN standards 
in the world. It is based on a local area network (LAN) protocol developed by Xerox Corporation in cooperation 
with DEC and Intel in 1976. Ethernet networks have a bus or star topology, provide for baseband data 
transmission at 10 Mbps, and use a variety of physical media: twisted pair (10BaseT), fiber-optic cabling (10BaseF) 
and coaxial cable (10Base2). To regulate communications on the network, Ethernet uses a form of access 
known as Carrier Sense Multiple Access with Collision Detection (CSMA/CD). The Ethernet standard continues to 
develop and evolve, with the emergence of 100BaseT (or Fast Ethernet, which operates at 100 Mbps) and 
Gigabit Ethernet (IEEE 802.3z, which operates at 1000 Mbps, or 1 Gbps). 

Extranet 
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An intranet that is partially accessible, with restricted access, to authorized outsiders. You can access an extranet 
only if you have a valid username and password. Your identity determines which parts of the extranet you can 
view. 

Fiber Optics 

Optical technology that transmits data using radiant light through fibers made of transparent materials such as 
glass, fused (vitreous) silica, or plastic. Fiber-optic cable can transmit signals at speeds up to 2 Gbps and is 
immune to eavesdropping and electromagnetic interference. Fiber-optic systems are either single-mode or 
multimode. Multimode is most often encountered in site LAN applications, while single-mode is mostly 
employed by Telcos. 

Firewall 

A security mechanism, or combination of mechanisms, designed for network access control and authentication. 
Firewalls detect and prevent unauthorized or unwanted traffic from a protected network. Mechanisms, 
functions, configurations, and effectiveness of firewalls vary widely. 

Gateway 

In networking, a device (usually a combination of software and hardware) that connects networks using 
different communication protocols so that information can be passed from devices on one network to the other. 

Half-router 

In BACnet, a device that can participate as one partner in a point-to-point (PTP) connection. Two half-routers 
form an active PTP connection and act as a single router. 

Hub 

A common connection point for nodes on a network. Hubs connect segments of a LAN and contain multiple 
ports. When a packet (message) arrives at one port, it is copied to all other ports. A passive hub is simply a 
conduit for data, much like a repeater. An intelligent hub (also called a manageable hub) offers features that 
enable an administrator to monitor traffic and configure ports. 

Instance 

In BACnet, a number that uniquely identifies an object within a device or a device on an internetwork. 

Internetwork 

A network made up of smaller, interconnected networks. Internetwork often refers to communication between 
one LAN and another over the Internet or another wide-area network (WAN). 

Intranet 

A network based on TCP/IP (an Internet) belonging to an organization and accessible only to members of that 
organization. Intranets appear just as any other web site, but are surrounded by a firewall that fends off 
unauthorized access. 

IP 
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Acronym for Internet Protocol. IP handles the breaking up of data messages into packets (also called 
datagrams), the routing of the packets from their origin to the destination network and node, and the 
reassembling of the packets into the data message at the destination. IP operates at the internetwork layer of 
the TCP/IP model, which is equivalent to the network layer of the ISO/OSI reference model. 

ISO/OSI Reference Model 

Short for International Standards Organization Open Systems Interconnection reference model. The model is 
the foundation of most network standards. It breaks down network communications into seven manageable, 
conceptual levels, each concerned with a specific aspect of network communications. The seven layers are 
Application, Presentation, Session, Transport, Network, Data Link, and Physical. 

LAN 

Acronym for Local Area Network. A distance-limited network for transferring data between computers or other 
digital devices. BACnet supports four types of LANs-Ethernet, ARCNET, MS/TP, and LonTalk. 

 

LONTALK® 
One of the LAN types BACnet devices may use. Like Ethernet and ARCNET, LonTalk uses a chipset for 
communications. However, unlike these network types, special development environments and tools available 
only from the Echelon Corporation are required to develop applications and nodes for it. LonTalk, like the other 
LAN types, is simply used to transmit BACnet messages from one device to another. LonTalk is often confused 
with LonMark and LonWorks, and all are often confused as being BACnet-compliant. An Ethernet device is not 
BACnet-compliant simply by virtue of using Ethernet, nor is a LonWorks or LonMark device BACnet-compliant 
simply by virtue of using LonTalk. LonMark products are not BACnet-compliant and require a gateway to 
interoperate. 

Media Access Control (MAC) 
The part of a network that handles access to the physical network (media). In BACnet, each device has a unique 
MAC Address/Network Number combination that identifies it on the BACnet internetwork. 

Metropolitan Area Network (MAN) 
A data network designed for a town or city. In terms of geographic size, MANs are larger than LANs, but smaller 
than WANs. MANs usually employ high-speed fiber-optic cabling and public networks. 

MS/TP LAN 
Acronym for Master-Slave/Token Passing Local Area Network, a LAN developed by the BACnet committee 
specifically for use on BACnet. MS/TP is a twisted-pair LAN based on the Electronic Industries Association (EIA) 
RS-485 signaling standard. It uses a token passing scheme for network communications. To initiate 
communications on the network, a node must have an electronic "token" (actually a small packet), which is 
passed from one node to another around the network. Master devices are allowed to have the token, whereas 
slaves are allowed only to respond to requests from masters. 

National Institute of Standards and Technology (NIST) 
An agency of the U.S. Department of Commerce's Technology Administration. The NIST charter is to strengthen 
the U.S. economy and improve the quality of life by working with industry to develop and apply technology, 
measurements, and standards. NIST has played an integral role in the development of BACnet. 
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Network 
A group of devices (computers, controllers, or other digital units) that are connected by communication 
facilities, such as twisted-pair cabling, coaxial cable, fiber-optic cable, or wireless means. 

Network Interface Card (NIC) 
Also called a network adapter, network card or expansion card. A device that connects a computer or other 
device to a LAN. For computers, the NIC is usually installed in an expansion slot and has a chip that handles the 
physical and data-link layers of network communications. 

Node 
A device (such as a computer or a controller) on a network that is capable of communicating with other 
network devices. 

Objects, Object Model 
Representing data in a defined data structures called objects. Each object has a set of properties and a group of 
functions that can be applied to them. BACnet defines objects to represent control system data. BACnet objects 
can represent information about a physical input or output, a file or a logical grouping of data that performs 
some function (a setpoint or schedule, for example). By prescribing an object-model method to represent all 
control system data, BACnet facilitates interoperability and extensibility. 

Peer-to-Peer 
A type of network in which each node has equivalent capabilities and responsibilities. 

Point-to-Point (PTP) 

A method of data transmission developed by the BACnet committee to provide serial communications between 
BACnet devices. Typically used for remote and roaming access to BACnet systems-dial-up communications over 
modems or a portable computer connection to a controller, for example. 

Property 

In object-oriented systems, a characteristic or parameter of an object. Properties of a file object in BACnet, for 
example, may include file size, type, and modification date. In BACnet, certain properties of an object may be 
required, while others may be optional. 

Protocol Implementation Conformance Statement (PICS) 

A document that details the particular BACnet objects, services, and capabilities supported by a type of BACnet 
device. Every BACnet-compliant device has an associated PICS published by the manufacturer. 

Repeater 

A network device that regenerates or replicates a signal. Repeaters are used in transmission systems to 
regenerate analog or digital signals distorted by transmission loss. A hub can operate as a repeater by relaying 
messages to all connected computers. A repeater cannot perform the intelligent routing performed by bridges 
and routers. 

Router 
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A device that connects two LANs. Routers are similar to bridges, but provide additional functions, such as 
message filtering and forwarding based on various criteria. 

Services, BACnet 

Services control the transfer of information such as scheduled commands and alarms between BACnet devices. 
The services provided by a BACnet device are generally described by the device's Conformance Class and 
detailed in its PICS. 

 

Switching Hub (SWITCH) 

In networking, a special type of hub that forwards packets to the appropriate port based on the packet's 
address. Switching hubs offer better performance than conventional hubs. Most switching hubs also support 
load balancing, which dynamically reassigns ports to LAN segments based on traffic patterns. 

 

TCP/IP 

Acronym for Transmission Control Protocol/Internet Protocol. TCP/IP is the de facto protocol standard used by 
the Internet. Whereas IP deals only with packet transmission, TCP enables two hosts to establish a connection 
and exchange streams of data. TCP handles delivery and order of data streams. 

 

Wide Area Network (WAN) 

A geographically widespread network, usually comprising one or more LANs. WANs are often connected 
through public networks, leased lines, and satellite or microwave communications. 



 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

 

 

 

 

 
AMERICAN AUTO-MATRIX 

ONE TECHNOLOGY LANE 

EXPORT, PA 15632 

(877) AAM-HVAC [P] 

(724) 327-6124 [F] 

 

 

 

CYLON ENERGY INC. 

8025 SOUTH WILLIAM STREET,  

SUITE 107,  

MANCHESTER, NH 03103 

T + 603-782-8870 

 

 

 

WWW.AAMATRIX.COM 


	SECTION 1 :  Using the NB-Link
	Interfacing with Controllers
	Connecting The BACnet Network
	Connecting NB-Link to a PC
	NB-Link Set-Up

	SECTION 2 :  USING NB-PRO
	NB-Pro System Requirements
	Installing NB-Pro
	To uninstall your old version of NB-Pro
	To Install the new version of NB-Pro
	To update the NB-Link firmware


	Polling for objects
	Detecting Devices
	Saving/Loading Device Lists
	Discovering Object Lists
	Working With Object Properties

	File Menu
	Save Device List
	Load Device List
	Exit

	Settings Menu
	NB-Link Preferences
	Network Configuration

	Discovery Menu
	Locate Devices
	Send “WHO IS”
	Add Device
	Discover Object List
	Rediscover Object

	Utilities  Menu
	Flash Update
	Time Synchronization
	Upload/Download
	Set Write Priority
	Standard Commandable Properties

	Report Generator
	Manual Read/Write
	Reading A Property Value
	Writing A Property Value
	Reading And Writing Bitmap Values

	Stat Display Sequence Editor
	Set Refresh Rate
	Property Information
	Prop Id Lists
	Property/Object Id Generator

	Viewer Utilities
	TREND VIEWER
	 TREND VIEWER TOOLBAR
	 TREND VIEWER PLOT WINDOW
	 TREND POINT SELECTION



	Modifying Trend Point Values
	 TREND POINT VALUE DISPLAY
	 CONFIGURING TRENDING
	ALARM VIEWER
	BACNET ERROR VIEWER

	Capture Menu
	Capture File Generation
	Download Capture File
	Download Capture File To GPC
	Disabling Download Information


	SPL Menu
	Open SPL File
	SPL Editor

	Help Menu
	About
	Icon Help


	SECTION 3 :  THE SPL EDITOR
	The SPL Editor
	File Menu
	Edit Menu
	View Menu
	Utilities Menu
	PLB File output
	LST File output
	Decompiler Options (defaults)

	Window Menu
	Help Menu
	Help Topics


	Toolbar

	SECTION 4 :  APPENDIX A:  STANDARD OBJECT AND PROPERTY IDENTIFIERS
	A. 1 Standard BACnet Object Identifier Numbers
	A.2 Standard Bacnet Property Identifier Number

	SECTION 5 :  APPENDIX B: TREND VIEWER
	Control
	Control>General
	Control>Title
	Control>Print
	Control>Hints
	Control>File I/O
	Control>Annotation Defaults

	Layout
	Channels
	Channels>General
	Channels>Trace
	Channels>Interpolation
	Channels>Marker
	Channels>Bar
	Channels>Fill
	Channels>Digital
	Channels>File I/O
	Channels>Stats

	Cursors
	Cursors>General
	Cursors>Hints

	Limits
	Limits>General

	Labels
	Labels>General

	X- and Y-Axes
	X- And Y-Axes>General
	X- And Y-Axes>Title
	X- And Y-Axes>Labels
	X- And Y-Axes>Tracking
	X- And Y-Axes>Cursor
	X- And Y-Axes>Scroll
	X- And Y-Axes>Scale
	X- And Y-Axes>Cartesian

	Legend
	Toolbar
	Data View
	Data View>General
	Dataview>Grid Lines
	X-Major, X-Minor, Y-Major, Y-Minor Sub-Tabs



	SECTION 6 :  APPENDIX C:  COMMISSIONING TIPS
	DEVICE NUMBERING
	MAX_INFO_FRAMES
	MAX_MASTER

	SECTION 7 :  APPENDIX D: TROUBLESHOOTING COMMON PROBLEMS
	PROBLEM: NB-Pro cannot connect to the NB-Link.
	SOLUTION:

	PROBLEM: When I start NB-Pro, I can see the IP address of my NB-Link in the Device Panel. However, I cannot see any MS/TP devices.
	SOLUTION:

	PROBLEM: NB-Pro cannot seem to find some devices on the MS/TP network.
	SOLUTION:

	PROBLEM: I changed my controller's ID number and now I can no longer communicate to the device.
	SOLUTION:

	PROBLEM:  NB-Pro will only discover devices up to a certain unit number.  If I try to add the device manually or perform a 'Send Who Is', the controller cannot be discovered.
	SOLUTION:

	PROBLEM:  When I attempt to open my capture file offline, I receive a message from Windows stating that I need to select a program to open it with. What program can I use to edit capture files?
	SOLUTION:


	SECTION 8 :  APPENDIX E:  GLOSSARY
	10BASET, 10BASE2, 10BASEF,100BASET
	American National Standards Institute (ANSI)
	American Society of Heating, Refrigerating and Air-Conditioning Engineers (ASHRAE)
	ARCNET
	BACnet®
	BACnet Interest Group (BIG)
	BACnet Interoperability Building Blocks (BIBBS)
	BACnet Manufacturers Association™ (BMA)
	BACnet Testing Laboratories™ (BTL)
	Bridge
	Client/Server
	Coaxial Cable
	Conformance Class
	Device, BACnet
	Ethernet
	Extranet
	Fiber Optics
	Firewall
	Gateway
	Half-router
	Hub
	Instance
	Internetwork
	Intranet
	IP
	ISO/OSI Reference Model
	LAN
	LONTALK®
	Media Access Control (MAC)
	Metropolitan Area Network (MAN)
	MS/TP LAN
	National Institute of Standards and Technology (NIST)
	Network
	Network Interface Card (NIC)
	Node
	Objects, Object Model
	Peer-to-Peer
	Point-to-Point (PTP)
	Property
	Protocol Implementation Conformance Statement (PICS)
	Repeater
	Router
	Services, BACnet
	Switching Hub (SWITCH)
	TCP/IP
	Wide Area Network (WAN)


